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Overzicht

1.1 Modulair ontwerp
Het systeem Access Professional Edition (hieronder Access PE genoemd) biedt onafhankelijke
toegangscontrole voor kleine en middelgrote bedrijven. Het bestaat uit meerdere modules:
—  LAC-service: een proces dat voortdurend communiceert met de LAC's (Local Access
Controllers - voortaan controllers genoemd). AMC's (Access Modular Controllers) worden
gebruikt als controllers.
—  Configurator
—  Personnel Management (Personeelsbeheer)
- Logviewer
—  Alarm Management (Alarmbeheer)
- Video Verification (Videoverificatie)
1.2 Server- en clientmodules
De modules kunnen worden onderverdeeld in server- en clientmodules.
Voor de LAC-service moet een continu contact met de controllers worden onderhouden. De
reden hiervoor is ten eerste dat de LAC-service continu berichten van de controllers ontvangt
m.b.t. bewegingen, aanwezigheid en afwezigheid van kaarthouders en op de tweede plaats dat
deze gegevenswijzigingen verstuurt, bijv. toewijzing van nieuwe kaarten aan de controllers,
maar vooral ook omdat deze controles op meerdere niveaus uitvoert
(toegangsvolgordecontroles, anti-passbackcontroles, willekeurige controles).
De Configurator moet op de server uitgevoerd worden, maar kan tevens op een client-
werkstation worden geinstalleerd en vanaf het werkstation worden bediend.
De modules Personnel Management (Personeelsmanagement) en LogViewer
(Logboekweergave) behoren tot de Client-component en kunnen ook op de server worden
uitgevoerd, of op een andere pc die over een netwerkverbinding met de server beschikt.
De volgende controllers kunnen worden gebruikt.
- AMC2 4W (met vier Wiegand-lezerinterfaces) - kan worden uitgebreid met een AMC2 4W-
EXT
—  AMC2 4R4 (met vier RS485-lezerinterfaces)
2018-05 | | APE-Personnel Management Bosch Access Systems GmbH
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2 Algemeen
2.1 Inleiding

Access PE is een toegangscontrolesysteem dat is ontworpen om kleine en middelgrote
installaties optimale veiligheid en flexibiliteit te bieden.

De stabiliteit en uitbreidbaarheid van Access PE is gebaseerd op een ontwerp met drie lagen:
de eerste laag is het beheerdersniveau met de besturingsservices. Alle beheerderstaken
worden op dit niveau uitgevoerd, zoals het registreren van nieuwe kaarten of het toewijzen van
toegangsrechten.

De tweede laag wordt gevormd door de Local Access Controllers (LAC's), die de verschillende
groepen deuren of ingangen beheren. Zelfs wanneer het systeem offline is, kan een LAC
onafhankelijk beslissingen nemen over toegangscontrole. LAC's zijn verantwoordelijk voor de
bediening van de ingangen, het bepalen van openingstijden, of verzoeken om PIN-codes bij
cruciale toegangspunten.

De derde laag bestaat uit kaartlezers.

De communicatie tussen client, server en kaarthouders is met AES versleuteld.

Met de Access PE-versie voor meerdere gebruikers kunt u met meerdere werkstations het
systeem besturen. Aanpasbare gebruikersrechtniveaus regelen de toegang en garanderen de
veiligheid. Hierdoor is het bijvoorbeeld mogelijk om vanaf het ene werkstation kaartgegevens
bij te werken, terwijl vanaf een ander werkstation wordt gecontroleerd of een bepaalde
werknemer in het gebouw aanwezig is.

Access PE biedt een uitzonderlijk flexibele configuratie van toegangsrechten, tijdmodellen en
toegangsparameters. De volgende lijst geeft een overzicht van de belangrijkste functies:
Snelle en eenvoudige toewijzing van kaarten

Kaarten (max. drie) kunnen handmatig aan personen worden toegewezen of met behulp van
een dialooglezer die via een seriéle verbinding is aangesloten op een pc. Alle toegewezen
kaarten zijn actief. Bij het upgraden van een kaart wordt de oude kaart automatisch
overschreven en ongeldig gemaakt. Dit betekent dat oude kaarten geen toegang meer bieden,
zelfs als de verantwoordelijke persoon de kaart vergat te annuleren of er niet in is geslaagd dit
te doen.

Toegangsrechten (inclusief groepsrechten)

Elke persoon kan groepsrechten overnemen naast de individuele rechten die aan hem zijn
toegewezen. Rechten kunnen gebieds- en tijdgebonden zijn en met een nauwkeurigheid van
één minuut worden beperkt. Groepsrechten kunnen worden gebruikt om toegangsrechten toe
te wijzen aan en te beperken voor een of meer kaarthouders tegelijk. Groepsrechten kunnen
afhankelijk gemaakt worden van tijJdmodellen die de toegang beperken tot bepaalde tijden van
de dag.

Toegangsregistratie

Door gebieden te definiéren kunt u controleren of het juiste traject wordt gevolgd en dit
wanneer nodig afdwingen. Zelfs zonder controle maakt deze configuratie het mogelijk om de
locatie van een kaarthouder weer te geven.

Anti-Passback

Wanneer een kaart gelezen is, kan deze voor een gedefinieerde periode geblokkeerd worden
zodat hij niet opnieuw gebruikt kan worden voor toegang in dezelfde toegangszone. Op die
manier kan "passback" worden voorkomen, waarbij een gebruiker zijn kaart over een barriére
aan een andere, niet-geautoriseerde persoon geeft om deze toegang te bieden.

Automatisch annuleren van kaarten na de einddatum

Bezoekers en tijdelijk personeel hebben vaak slechts een beperkte periode toegang nodig.

Bosch Access Systems GmbH APE-Personnel Management 2018-05 | |
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Kaarten kunnen voor een specifieke periode worden geregistreerd, zodat ze automatisch
ongeldig worden nadat de betreffende periode is verstreken.

Tijdmodellen en dagmodellen

Aan een kaarthouder kunnen specifieke tijdmodellen toegewezen worden, die de
toegangsuren voor die persoon bepalen. Tijdmodellen kunnen flexibel gedefinieerd worden
door gebruik te maken van dagmodellen die bepalen hoe specifieke weekdagen, weekends,
feestdagen en bijzondere dagen afwijken van normale werkdagen.

Identificatie via PIN-code

Een persoon kan in plaats van een kaart een speciale PIN-code gebruiken om naar binnen te
gaan.

Verificatie via PIN-code

De toegang tot bijzonder vertrouwelijke gebieden kan worden beperkt met behulp van extra
PIN-codes. Deze beveiliging kan op haar beurt afhankelijk gemaakt worden van tijJdmodellen,
zodat een PIN-code bijvoorbeeld alleen vereist is gedurende feestdagen of buiten normale
werktijden.

Flexibel deurbeheer

Flexibel definiéren van parameters voor afzonderlijke deurmodellen maakt een optimaal
evenwicht tussen veiligheid en comfort mogelijk. De alarmonderdrukkingsperiode kan per deur
worden ingesteld om te bepalen hoe lang een deur geopend mag blijven. Na het verstrijken
van deze periode kan het toegangspunt desgewenst worden vergrendeld in combinatie met
een alarmsysteem.

Periodiek vrijgeven van deur

U kunt de toegang vergemakkelijken door deuralarmen te onderdrukken om deuren gedurende
een bepaalde periode vrij te geven. De vrijgaveperiodes van deuren kunnen handmatig of
automatisch via een tijdmodel worden gedefinieerd.

Tijd en aanwezigheid

Voor toegangszones kunnen parameters gedefinieerd worden voor het registreren van de
binnenkomst en het vertrek van personen ten behoeve van het tijds- en aanwezigheidsbeheer.
Type ID-kaart

De grafische invoegmodule Card Personalization (CP) is volledig in het
toegangscontrolesysteem geintegreerd zodat de operator kaarten kan maken zonder tussen
verschillende toepassingen te hoeven schakelen.

Toewijzen van foto's

Zelfs als de invoegmodule Card Personalization (CP) niet is geactiveerd, blijft het mogelijk om
fotografische identificatie te importeren en aan kaarthouders te koppelen.

Offline locking system (Offline-afsluitsysteem)

Gebieden die om een bepaalde reden niet zijn afgesloten door het online
toegangscontrolesysteem met hoge beschikbaarheid, kunnen offline alsnog worden
afgesloten.

Beheer van video-apparatuur

Ingangen kunnen extra worden voorzien van camera's om de bewegingen van aanwezige
personen te registreren en te volgen.

2.2 Aanmelden gebruiker
De volgende toepassingen zijn beschikbaar. Raadpleeg de betreffende
gebruikershandleidingen voor meer informatie:

2018-05 | | APE-Personnel Management Bosch Access Systems GmbH
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&+ BOSCH Personnel Management (Personeelsbeheer)

(&

i+ BOSCH] Configurator

4 BOSCH Logviewer (Logboekweergave)

&

"4 BOSCH Map and Alarm Management (Plattegrond-
en alarmbeheer)

'Y

"4 BOSCH Video Verification (Videoverificatie)

=N

Bericht!

Aanmelden op de client is alleen mogelijk als de LAC-service wordt uitgevoerd op de server.

Aanmelden op client

De toepassingen van het systeem zijn beveiligd tegen niet-geautoriseerd gebruik. De
standaardwachtwoorden bij het eerste gebruik zijn:

—  Gebruikersnaam: bosch

- Wachtwoord: bosch

’% Personaleernaltung @

Language selection

Language |EM - Englizh ﬂ

Ilzer

Start the application

Usemame |
El Delete contents
Paszwiard |

Cancel

Na het invoeren van een gebruikersnaam en wachtwoord wordt de knop Change Password
(Wachtwoord wijzigen) actief.

Na drie mislukte pogingen duurt het enige tijd voordat opnieuw kan worden aangemeld. Dit
geldt voor de knoppen "Start the Application" (Toepassing starten) en "Change

Password" (Wachtwoord wijzigen).

In de bovenste keuzelijst kunt u de gewenste taal voor interactie selecteren. Standaard is dat
de taal die is gebruikt om de toepassing te installeren. Als een volgende gebruiker de
toepassing niet opnieuw opstart, blijft de eerder ingestelde taal actief. Het is dan mogelijk da

er een dialoogvenster in een ongewenste taal wordt weergegeven. Om dit te voorkomen, dient

u zich nogmaals bij Access PE aan te melden.
Access PE toepassingen kunnen worden uitgevoerd in de volgende talen:

t

Bosch Access Systems GmbH APE-Personnel Management 2018-05
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- Engels

—  Duits

- Frans

- Japans

- Russisch

- Pools

—  Chinees (PRC)

- Nederlands

- Spaans

—  Portugees (Brazilié)

Bericht!

Alle voorzieningen zoals apparaatnamen, labels, modellen en gebruikersautorisatieschema's
worden weergegeven in de taal waarin ze zijn ingevoerd. Knoppen en labels die afhankelijk
zijn van het besturingssysteem, worden mogelijk weergegeven in de taal van het
besturingssysteem.

md 0

Nadat u op de knop Change Password (Wachtwoord wijzigen) hebt geklikt, voert u een
nieuwe gebruikersnaam en een nieuw wachtwoord in dit dialoogvenster in:

-

Change password

Mew pazsword ||

Confirmation |

Ok | LCancel

Bericht!
Vergeet niet het wachtwoord te wijzigen!

md 0

Met de knop Start the application (Toepassing starten) worden de rechten van de gebruiker
gecontroleerd en op basis hiervan de toepassing gestart. Als het systeem de
aanmeldingsgegevens niet kan verifiéren, verschijnt het volgende foutbericht: Wrong
username or password! (Gebruiker of wachtwoord is onjuist).

2018-05 | | APE-Personnel Management Bosch Access Systems GmbH
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2.3 Indeling van Personnel Management (Personeelsbeheer)
Het dialoogvenster bestaat uit de volgende onderdelen:
L -7 ERSION - Access Professional Edition - Personnel Management - [bosch] Al (=2 =n ===
PR R v S—————
) BOSCH
/[ Card[ Card3[Name Parsonnel group | Location
=1 _Korl_|Employees —outsice— Administrator <. 1.
4 NewVis New Vis — unknown —
MNewYisDetAuth, dd | New Vis — unknown —
Testl, Hilde Employses — unknown —
Testpersanl Employees —unknown —
(Person has no card assigned)
Cunent Absent 5 I~ Set present
Remat | ReE e
Mema Mema W.E5200912506
Preview T —
Memo | i)
Print
Device states ‘Areas ‘\/\dend eeeeee ‘ Location K’ W.0520091350 27
=3 LaC- Phs - unknown - -
& ;A EA‘m:ess point | e & LE S
B Entyreadert T Cand status
B Esitreader 1 € explicit blocked ‘
Special messages on the reader @ valid € 3w wrong pininput b
Name [Admirisiiator ® el cEeay, B
onartl [ |

Menubalk — bevat dialoogvensterfuncties die worden
weergegeven in de menuvolgorde.

Werkbalk — bevat sneltoetsen voor de belangrijkste
dialoogvensterfuncties.

Titelbalk — komt overeen met de standaardvensters van
Windows en bevat knoppen voor het minimaliseren of
sluiten van het dialoogvenster. De naam van de
geregistreerde gebruiker wordt tussen vierkante haakjes
weergegeven.

Personeelstabel — een lijst van alle personen die in het
systeem bekend zijn, samen met hun
aanwezigheidsstatus (autorisatie en locatie).

Dialoogvensterveld — de eerste keer dat dit veld wordt
geopend of wanneer er geen gebruiker zich heeft
aangemeld, wordt hier een neutrale afbeelding
weergegeven. Wanneer er een item is geselecteerd in de
personeelslijst, worden hier de gegevens van deze
persoon weergegeven.

Online-kaartleesgegevens — toont de laatste vijf
personen (samen met hun foto uit de database) die hun
kaart bij de geselecteerde ingang door de kaartlezer
hebben gehaald.

Apparaatstatus - toont de geconfigureerde apparaten
en ingangen en hun verbindingsstatus. Maakt
deurbesturingsfuncties mogelijk.

Bosch Access Systems GmbH
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8= Gebeurtenissen — fouten worden weergegeven door
een knipperende rode balk (knippert drie keer) met
informatie over de oorzaak.

9= Statusbalk — toont informatie over knoppen en
menuopties die worden geselecteerd met de muis. De
statusweergave voor het

kaartpersonaliseringsprogramma, dialooglezers en LAC-

service.

24 Werkbalk van Personnel Management (Personeelsbeheer)
De volgende functies zijn beschikbaar via de menu's of werkbalkknoppen.
Functie Pictogr |Beschrijving

am

Menu Options (Opties)

Vernieuwen @ De personeelslijst vernieuwen.

Afsluiten Hiermee sluit u de toepassing
Access PE Personnel
Management af.

Menu Persons (Personen)

New person Hiermee opent u een leeg

(Nieuwe persoon) dialoogvenster voor het
invoeren van personeels- en
kaartgegevens.

Modify person , Hiermee opent u het

(Persoon 74 dialoogvenster voor personeels-

wijzigen) en kaartgegevens met de
gegevens van de geselecteerde
persoon.

Delete person Hiermee verwijdert u de

(Persoon geselecteerde persoon (nadat u

verwijderen) dit hebt bevestigd in het
venster dat verschijnt).

Transmit selected Hiermee verzendt u de

person to the LAC gegevens van de geselecteerde

service persoon naar de LAC-service,

(Geselecteerde waarna wordt gemeld of het

persoon naar LAC- verzenden met succes is

service uitgevoerd.

verzenden)

2018-05 | | APE-Personnel Management Bosch Access Systems GmbH
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Functie Pictogr |Beschrijving

am
Transmit all Hiermee verzendt u de
persons to the gegevens van alle personen
LAC service (Alle naar de LAC-service, waarna
personen naar wordt gemeld of het verzenden
LAC-service met succes is uitgevoerd.
verzenden)
Set all persons Hiermee stelt u alle personen in
absent (Alle als afwezig (nadat u dit hebt
personen instellen bevestigd in het venster dat
als afwezig) verschijnt).
Set location of all Hiermee stelt u de locatie van
persons present alle personen in op onbekend
to unknown en schakelt u de
(Locatie van alle toegangsregistratie voor de
aanwezige volgende aanmelding van elke
personen instellen persoon uit.

op onbekend)

Personen Opent het dialoogvenster voor
opruimen het opruimen van de
personendatabase

View/print reports |._I| Opent het dialoogvenster voor
(Rapporten .l. het maken van rapportlijsten.
weergeven/
afdrukken)

List Alleen de personen uit de

control |geselecteerde groep worden
(Lijstco | weergegeven.

ntrole)

Menu View (Beeld)

Symbol bar De werkbalk weergeven/

(Werkbalk) verbergen. Standaard =
weergeven.

Status&balk De statusbalk weergeven/
verbergen. Standaard =
weergeven.

Bosch Access Systems GmbH APE-Personnel Management 2018-05 | |
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Functie

Pictogr
am

Beschrijving

Personnel data:
(Personeelsgegev
ens:)

Toestand

Card No.
(Kaartnr.)
Personnel-No.
(Personeelsnr.)
Bedrijf

Personnel Group
(Personeelsgroep)
Telefoon

Locatie

Selecteer de kolommen die
naast de symbool- en

naamkolom in de personeelslijst

moeten worden weergegeven.
Standaard = State (Status) -
Company (Bedrijf) - Location
(Locatie)

Menu Door management (Deurbeheer)

open door (Deur |Deze De ingang die in de
openen) functie |apparatenlijst is geselecteerd,

s zijn wordt weergegeven en kan

ook worden geopend (één keer).
Long-term open beschik De ingang die in de
(Langdurig b'aar apparatenlijst is geselecteerd,
openen) via het wordt weergegeven en kan

snelme .

U (langdurig) worden geopend.
lock door (Deur (met De ingang die in de
vergrendelen) de apparatenlijst is geselecteerd,

rechter | wordt weergegeven en kan

muiskn | worden vergrendeld.

op op

de

gewens

te

deur/

ingang

klikken

).

Menu Tools

User logon Hiermee kunt u zich aan- of
(Gebruiker afmelden bij Personnel
aanmelden) Management

(Personeelsbeheer).

Execute the
Configurator
(Configurator
starten)

Hiermee start u Configurator en
brengt u gegevens over van
Personnel Management
(Personeelsbeheer).

2018-05 | |
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Functie Pictogr |Beschrijving

Execute log
viewer (Log
Viewer starten)

Hiermee start u Log Viewer
(Logboekweergave) en brengt u
gegevens over van Personnel
Management
(Personeelsbeheer).

Execute Video
verification (Video
Verification

Start de toepassing voor het
uitvoeren van de
videoverificatie.
starten)

Execute Map & Start de toepassing Map &

Alarm Alarm Management voor het
Management beheren van plattegronden en
(Map & Alarm alarmen.

Management

starten)

Video panel Toont vier displays in het

E m @N
E 3

(Videopaneel) dialoogvenster voor
afzonderlijke

videocamerabeelden.

Properties Hiermee opent u een
dialoogvenster met algemene
systeeminstellingen.

Menu ? (Help)

Help topics (Help- e Dit Help-bestand openen.
onderwerpen)

About Access Hiermee geeft u informatie over
Personal Edition - Personnel Management
Personnel (Personeelsbeheer) weer.
Management

(Info...)

Bosch Access Systems GmbH APE-Personnel Management 2018-05 | |
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241 Personen opruimen
Als u een aantal personen wilt verwijderen die niet meer in het systeem hoeven te blijven,
selecteert u Cleanup persons (Personen opruimen) in het vervolgkeuzemenu Persons
(Personen).

L Access Professional Edition - Personnel Management - [bosch]

Options | Persons  View Door management  Tools 7

New person am
. 8= A0

Modify person

Delete person Pe)

Transmit selected person to LAC service

Transmit all persons to LAC service

Set all persons absent

Set location of all present persans to — unk

Cleanup persons

View/print reports

Katharina | | -~ unknown
. Olaf | |~ unknown -

Een lijst met een aantal personen wordt weergegeven. U kunt personen selecteren met

verschillende filtercriteria. Personen met bestaande gebruikersrechten worden niet

weergegeven. Het volgende voorbeeld heeft betrekking op personen waaraan geen kaart is

toegewezen.

—  Selecteer de personen die moeten worden verwijderd.

—  Klik op de knop Delete selected persons (Geselecteerde personen verwijderen)
onderaan.

—  Klik op het zoeksymbool om de selectie bij te werken.

Cleanup Persons x
Persons group I i Company I @
Last access less f equal I :l‘ Without assigned Card v
MName ¢ | Company f Dep. Personnel group Last Access

H=|q=, Steinauer Visitors 20.04.2018 13:26
_ 20.04.2018
Huhn:rmund, Siggi 20.04.20

Jochen, Palm 20.04.20

02, Coszikore _ 208,208 1333

20.04.

Delete selected persons I Close

2.5 Registratieconfiguratie

Met Personnel Management > Tools > Properties (Personeelsbeheer > Tools >
Eigenschappen) opent u een dialoogvenster waarin basisconfiguratietaken (activeren,
wijzigen) kunnen worden uitgevoerd vanaf elk willekeurig werkstation.

2018-05 | | APE-Personnel Management Bosch Access Systems GmbH
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L - TRIAL-VERSION - Access P i Edition - I - [bosch]

Options  Persons View Door management [Tools | ?

E 1- ), G ri m User logen

Execute Configurator

il I Execute LogViewer
Card | Namea Execute Video verification
Administrator Execute Alarm & Map Management
=] 2| Nettelbeck 2233 IdPIN 1223 V,

Test, Initl Video panel
Testperson. Test
Vis2, Zwei

w

Properties

— Administratieve werkplekken, waar kaarten worden toegewezen aan personen, kunnen
worden voorzien van een registratielezer. Deze moet worden ingesteld en geconfigureerd
in overeenstemming met de specificaties van de fabrikant of de instructies die bij het
apparaat worden geleverd. Als een registratielezer is ingesteld, wordt de handmatige

kaartcontrole automatisch uitgeschakeld.
De vereiste instellingen voor ondersteunde lezers zijn:

Naam van lezer BAUD D P S
DELTA 1200 Prox RS232 9600 8 N 1
DELTA 1200 iClass RS232 57600 8 E 1
DELTA 1200 USB Hitag, Legic, Mifare 9600 8 N 1
DELTA 1200 RS232 Hitag, Legic, Mifare 19200 8 N 1
Rosslare ARD-1200EM USB 9600 8 N 1
LECTUS secure 5000 MD 9600 8 N 1
D= Databits N = geen
P = Pariteit E= even
S = Stopbits 0= oneven
° Bericht!
l De Delta 1200 Series en Rosslare ARD-1200EM Series zijn niet geévalueerd door UL.
Gevolgen
—  Chipkaartsysteem

Geeft de kaarttechnologie weer — MIFARE classic en Hitagl kunnen worden gebruikt voor

Access PE.

Bosch Access Systems GmbH APE-Personnel Management
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Change Configuration

Attention:

5 ]Es)

This properties wil be activated immediately. This may take some time (look at the status bar).

This properties wil be stored permanently and wil already be activated after a restart of your

computer.

¥ Enrollment Reader  Reader type \LEcrus enroll 5000 MD - MIFARE Dats Remrd(ﬂ'j

[ CP system for card personalization installed

Card type |32 Bit CSN - Standard Mifare (328it) |

COMS: A

Baudrate |9500 hd

" even " odd
8

C2

IV Connect to LAC service (transmit all card changes immediately to the subsystem)

I™" Do not show dialog for edit and view internal card information

I™" Enable THAI font for reports (use spezial font)

Cancel

Als het systeem is geinstalleerd met de optionele module Card Personalization (CP), is
het overeenkomstige selectievakje in Settings (Instellingen) ingeschakeld. Als u dit
selectievakje uitschakelt, worden alle functies voor het ontwerpen/maken van kaarten
inactief.

Daarnaast is ook de automatische overdracht van personeelsgegevens via Connection to
the LAC Server (Verbinding met LAC-server) ingeschakeld. Het wordt aanbevolen dat dit
selectievakje altijd is ingeschakeld.

U kunt hier de weergave van kaartgegevens tijdens het toewijzen van kaarten
uitschakelen. De weergave hiervan is alleen noodzakelijk wanneer in tegenstelling tot de
standaardinstellingen (zie General Settings (Algemene instellingen) in Access PE
Configurator) kaartgegevens zijn vereist die niet overeenkomen met de
standaardinstellingen van het bedrijf.

Klik op het selectievakje Enable THAI fonts for report (Thaise lettertypen inschakelen
voor rapporten) als rapporten in de Thaise taal zijn vereist. OPMERKING: dit werkt alleen
in de Engelse taal.

25.1 Registratie via lezers aangesloten op AMC
Zorg dat ten minste één lezer is geconfigureerd met een Deurmodel 06c, het deurmodel voor
registratie.
Start de Configurator en selecteer een Lokale toegangscontroller (LAC) (bijvoorbeeld
AMC2 Wiegand).
2018-05 | | APE-Personnel Management
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F Active.acf - Access Professional Edition

File View Configuration Settings 7

[=1 Settings

~Local access controller

) x]

No. ; | Address | Type

1 AMC2-4R4 0SDP

Project version | Connection
UDP.:54546>172.23.1.251:10001>NONE

Version enabled

Default card data [~ PIN cod
( Countrycode [00 Customer code [056720 ‘ Number of digits [4 = Number of retries before blocking [ 3 —
I™ use separate DS pin Number of digits for identification [4 =
Logbook parameter
’VNumber of fles [366 =1 (one logflle per day, 0 = unlimited) ‘
LAC proce: [~ Directori

Poll interval on serial connected LAC in ms I 200 :,‘
Read-timeout on serial connected LAC in ms I 500 -

Create TA-data at | 00:01 =+

I~ Export personnel and TA data

Database | C:\Bosch\Access Professional Edition\PE\Data\Db

Eventlog | C:\Bosch\Access Professional Edition \PE\DataMsgl:

Import files | C:\Bosch\Access Professional Edition\PE\Data\Impa:

Export files | C:\Bosch\Access Professional Edition\PE\Data \Expal

L s

DLL-files | C:\BoschAccess Professional Edition\PE\Data\Dll

[¥ Show welcome leaving message

Iv Show cardholder name in display

Pictures | C:\Bosch\Access Professional Edition\PE\Data Pictur

Testlogs | C:\Bosch\Access Professional Edition\PE\Data\L.og

~5QL-Server Database ——————————
e [acoemaz
Instance l—
User l—
Password l—

Check 501 Database Connection |

APE Database | BOSCH AccessPE

Create APE Database |

] Activate SOL-Database

F1 for help

Klik op het symbool Ingangen en voeg een nieuwe ingangslezer toe:

Define Entrance

Description |t

? x

Please corfigure LAC, GID and doommodel

Door mode! [03a - Revolving door with erry and et reader

5

I7 Video verfication  Sury. camera: [Camera APE Video corfiguration |

- Reader

rfiguration
Readertps  Address

Enty-  [Rs4gs5 -1

reader 4

Ext

reader

Eoc I

read only -

ead only -

Wirite access

~ Signal defintion

On dev GID /

Board

Sigral descrption

Connection

Revolving door in nomal post

Pushbutton: Doar apen

Entrance locked

Sabetage signal

v

Cancel

Het dialoogvenster Entrances (Ingangen) wordt geopend:

Bosch Access Systems GmbH
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F tctive act - Access Prafessional Edition - Canfigurator - TRIAL-VERSIONM - [basch] (=@ =]
File  View Configuration 7
o oo @ BOSCH
|i Entrances
Seftings
+|#] x| LeC [ 1 GID[1 Model [01a- Common doot with entry and exit reader
+ | Mame Door gettings
(l } I Activation time 40  — ¥ Door contact
DOpen time |300 [ Baolt contact
[~ Part of a door- I
Camera activation time | 100 = CIC CICREREE.
Alarm suppression time: =7 ol IS ER e
for contral mechanism — I Door status events
Entry reader settings
@ Aocess only I~ Random personnel soreening Rate = ¥ with keypad
" priving [~ Antipassback ........oooooooovriioeerieee oonr. Timeout ’—:C min.  Group id ’_ [~ Grant access on wite emor
" Leaving ™ Entry a5 group ....ccceeeeees required number of persans = Persans
" Check ok ™ Mo time model check [~ Motor move-in w W ‘write without access rights

™ Push button
[V with viden verification

Exilt reader settings

[ Random personnel screening............o......... Rate == | 53 [ “with keypad
[~ Anii-passhack Timeout == min. Groupid [~ Grant access on wite ermor

% Access only

7 Ariving
 Leaving ™ Mo time model check I~ Motor move-in configure W ‘wiite without access rights
™ Push button I enabled when armed
[ with video verification
Unlock door PIN code at entry reader
* Nomal = None I~ PIN or card
" Long-tem apen  Always Door-FIN ﬂ

" Per time model " Per time model:

IS ’—4| Confirm PIN

o) per time modek:
o
- hone - A
Activation of matorlock o
- hone - -

Per time model

In dit dialoogvenster voert u de volgende handelingen uit:

—  Voer een omschrijving in (bijv. Registratielezer AMC)

—  Selecteer een LAC en een groep-ID (GID)

—  Selecteer een lezertype (bijv. Wiegand)

—  Selecteer een nummer tussen 1 en 8 als adres voor de registratielezer
Klik op OK om de configuratie van de registratie te bevestigen.

Om de geconfigureerde registratielezer aan een specifiek werkstation toe te wijzen, schakelt u
over op de APE-client.
—  Select Tool > Properties (Tool selecteren > Eigenschappen).

Change Configuration ? X

Attention:
This properties will be activated immediately. This may take some time (ook at the status bar).

This properties wil be stared permanently and will aready be activated after a restart of your
computer,

I Enroliment Reader;  Reader type [Delta 1200 R5232 Prox, iClass (WIE1) ~|

Card type [HID 26 - Standard Wiegand 25 Bit Code |

Serial |COM1L: -

Baudrate (9500 -
Parity (* none " even " odd
Data bits ~ 7 v 8

Stop bits @& 1 2z

¥ CP system for card personalization installed
V¥ Connect to LAC service (transmit all card changes immediately to the subsystem)

I Do not show dialog for edit and view internal card information

I~ Enable THAI font for reports (use spezial font)

Selecteer een beschikbare registratielezer om het registratieproces te starten.

2018-05 | |
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Controleer of uw registratielezer online is.

Indien u niet direct een reactie hebt ontvangen, dient u het dialoogvenster Personnel
Management (Personeelsmanagement) te openen.

k- ac3x0052un2 - Remotedes rbindur

[ - TRAL-VERION - Access Profesional Editon - Personriel Management - [osch]

Options  Persons Wiew Doormanagemnent  Tools I
Administrator s Administrator
106 Aznavour, Brian
109 Cocker, Janis Employees —outside —
102 Hooper, Lea Employees —outside —
105 Jones, Charles Employees inside
10 Joplin, Joseph Employees —outside —
104 Knebel, Hilde Employees — outside —
McVaughan, Jim Employees — outside —
108 Morrison, Stevie Ray | Employees —unkngwn —
101 Mustermann, Karl | Employees —unkngwn —
12 New Vis, 1 Visitars. — unknown — Card-No. 1 g
mn New Vis, 2 Visitars — outside —
103 Palatschik Herbert | Emplayees inside Curert. Manualy set to present on 30.09.2016 14:06 I Setsbsent
Remavkl
Mena e
Mermo
Bt
Location
prone | s =l
Codstas
" enplicit blocked
@ valid  © 3wrongpininput
Name lm " selected for random screering
R
onewing [
Save Carcel (oo |
Devi tates | areas | Video devioes
B e ad
< 3

Bosch Access Systems GmbH APE-Personnel Management 2018-05 | |
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3

Personnel Management (Personeelsbeheer)

Dit dialoogvenster is de hoofdtoepassing van de werkstations. Behalve gegevensopslag en
bewerkingsfaciliteiten toont dit dialoogvenster ook locaties van personen en eventuele
blokkeringen tegen deze personen. U kunt daarnaast systeembewakingsprocedures uitvoeren
via de deurbedieningsfuncties en apparaatstatusweergaven.

3.1 Personenlijst
De personenlijst bevat alle personen die in het systeem staan. Standaard worden achternaam,
voornaam en bedrijf of afdeling weergegeven. Een aparte kolom met symbolen biedt de
volgende aanvullende informatie over de status van de persoon of kaart:
De persoon heeft geen kaart
= De persoon is afwezig.
= De persoon is aanwezig.
= De persoon is afwezig en geblokkeerd. Het
dialoogvenster bevat ook een knipperlichtje.
ER De persoon is aanwezig maar geblokkeerd. Het
dialoogvenster bevat ook een knipperlichtje.
| Card| MNarne ¢ ‘ Personnel group |LDcaUDn
= Administrator Employees Server Room
23] 106 | Aznawour, Brian Employees inside
B 109 | Cocker. Janis Employaes — outside —
[2=] 102 | Hooper, Leo Employess — outside —
23] 105 | Jones, Charles Employees inside
= 110 | Joplin, Joseph Employees — outside —
=] 104 | Knebel Hilde Employees — outside —
McYaughan, Jim Employess — outside —
= 108 | Morrison, Stevie Ray | Employees — unknown —
-] 101 | Mustermann, Karl Employees — unknown —
= 12| Mew Wis. 1 ‘igitors — outside —
[2a) 11 | New Vis, 2 isitors — unknown —
= 103 | Palatschik, Herbert | Employees inside
De standaard lijstweergave met de kolommen Symbol (Symbool), Name (Naam) en Company/
Dept. (Bedrijf/Afd.) kan voor elk werkstation worden aangepast. Gebruik het menu View >
Personnel Data (Beeld > Personeelsgegevens) om kolommen toe te voegen of te verwijderen.
Weergegeven kolommen zijn gemarkeerd met een vinkje. Wanneer u een weergegeven kolom
nogmaals selecteert, schakelt u de weergave uit, en omgekeerd.
De volgende extra kolommen zijn beschikbaar:
—  card No. (kaartnr.)
—  Personnel No. (Personeelsnr.)
—  Company / Dept. (Bedrijf / Afd.)
—  Personnel Group (Personeelsgroep)
— Telephone (Telefoon)
—  Location (Locatie) (als gebieden zijn gedefinieerd)
—  Picture (Foto)
—  Last access (Laatste toegang)
2018-05 | | APE-Personnel Management Bosch Access Systems GmbH
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=

Bericht!

Mogelijk worden niet alle geselecteerde kolommen weergegeven als de huidige breedte van
het lijstvenster te klein is. In dat geval past u de breedte van het venster aan. U kunt
desgewenst ook de volgorde van de kolommen in het venster wijzigen. De volgorde van de
kolommen kan worden gewijzigd door de kolomkoppen naar de gewenste plaats te slepen.
Houd er rekening mee dat bij het verbreden van de personenlijst ook de breedte van het
dialoogvenster aan de rechterkant van de lijst wordt aangepast.

De werkbalk bevat een keuzelijst met invoervak voor het filteren van de personenlijst.
Standaard worden alle personen weergegeven onder Employees (Personeel) of Visitors
(Bezoekers).

All persons v

All persons
Employees
Yisitors

Opmerking: als u een extra groep toevoegt (bijv. VIP's), worden de leden van die groep
automatisch weergegeven onder Employees (Personeel).

U kunt de kolom Picture (Foto) toevoegen aan de personenlijst. U kunt de kolom tonen of
verbergen via het menu View > Personnel data > Picture (Beeld > Personeelsgegevens >
Foto).

Deze kolom bevindt zich uiterst rechts. U zult daarom soms moeten bladeren door de
personenlijst om deze zichtbaar te maken. Andere kolommen zijn wellicht verborgen.

Card | Mame ’
106 | Brocker, Heinz

109 | Biising, Gerhard

102 | Christian, Thomas
105 | Dabs, Andreas

110 | Delesen, Frank

104 | Fallmann, Inna

Fuhs, Wolfgang

108 | GilleBen, Harald

101 | Hannewald, Joachim
12 | hans

11 | Herrmann, Falk ]
103 | Krirmmel, Thorsten

HEEGGDRERGR R

=

Bericht!

Deze afbeeldingen passen in de lengte van de kolom. Het is daarom moeilijk personen te
identificeren wanneer het display klein is. De belangrijkste reden voor het weergeven van de
afbeeldingen is om gebruikers in staat te stellen snel te controleren voor welke personen er
nog geen foto is opgeslagen.

Bosch Access Systems GmbH APE-Personnel Management 2018-05 | |
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3.2 Dialoogvenster voor personeelsgegevens

Als u een item selecteert in de personenlijst, worden de gegevens van de betreffende persoon
weergegeven in het dialoogvenster aan de rechterkant.

Victor All

Card-No. 577

Current  Present since 08.05.2009 15:50 [~ Set absent

Remark |\
Mema Memo
Dreview
Memo
print

Location

FPhone | in der Firma [anwesend) Li
Special messages on the reader Card status
Mo |Victor &l " enplicit blocked
@ yalid 3w wrong pin input

On arrival ]Gnnd morning :
" selected for random screening

Save | Lancel | Cloze

In dit dialoogvenster kunt u niet alleen de belangrijkste personeelsgegevens weergeven maar
ook verschillende functies activeren.

On leaving ]Guud bye

Weergave/Functie Beschrijving

Name (Naam) Alleen weergave - voor wijzigingen
(Title - First name - Last | gebruikt u het wijzigingsvenster -
name) (Titel - Voornaam | Personeels- en kaartgegevens, pagina
- Achternaam) 34.

Company/Dept.
(Bedrijf/Afd.)

Personnel-No.
(Personeelsnr.)

Card No. (Kaartnr.)

Photo (Foto)

Current Status (Huidige | Aanwezigheids-/
status) afwezigheidsweergave inclusief
datum.

Set present (Instellen Afhankelijk van de huidige status

als aanwezig), Set kunt u de persoon hier als aanwezig
absent (Instellen als of afwezig instellen.
afwezig)
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Weergave/Functie

Beschrijving

Notes (Opmerkingen)

Ruimte voor eigen tekst over deze
persoon. Max. 50 tekens.

Memo

Ruimte voor eigen memotekst over
deze persoon. Max. 300 tekens.

Memo preview/ Print
Memo
(Memovoorbeeld/Memo
afdrukken)

De memotekst kan worden
weergegeven of afgedrukt volgens
een vooraf gedefinieerde afdruklay-
out.

Telephone (Telefoon)

Het telefoonnummer of ander
nummer waarop deze persoon te
bereiken is.

Location (Locatie)

De locatie van een persoon
weergeven en wijzigen. U kunt een
willekeurig gebied selecteren,
evenals de standaardwaarde -
unknown -- (onbekend).

Special messages on
the reader (Speciale
berichten op de lezer)

elke regel van het scherm kan
maximaal 20 tekens bevatten

Name (Naam)

De naam van de persoon zoals deze
moet worden weergegeven door
lezers die over deze
weergavefunctie beschikken.

On arrival (Bij
aankomst)

Speciale welkomsttekst.

On leaving (Bij vertrek)

Speciale afscheidstekst.

Card status

(Kaartstatus)

- valid (geldig) De kaartstatus weergeven en

—  explicitly blocked | wijzigen. De volgende
(expliciet kaartparameters kunnen hier

geblokkeerd)

- 3xwrong PIN input
(38x onjuiste invoer
PIN-code)

—  Selected for
random screening
(Geselecteerd voor
willekeurige
controle)

worden ingesteld.

Bosch Access Systems GmbH
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3.3 Apparaatstatus
Het derde deelvenster van het hoofdvenster voor personeelsbeheer, Device status
(Apparaatstatus), bevindt zich onder de personeelslijst.
De apparaatstatus wordt naast de lijst met logboekmeldingen weergegeven.
Device states |.Pcreas I Video devices I
B Lac-1
E| JE, Access point
----- B Access control reader
E| Jl 'lstﬂcornght
5 = Eniry reader 1
i b ‘ Exit reader 1
El J] 15t floor left
Eniry reader 1
n. Exit reader 1
E| ﬂ garage
----- .-k Access control reader
De volgende symbolen geven de apparaatstatus aan:
Apparaatstatus Symbool
Controller is online E
Controller is offline E
Verbinding met de controller kan niet worden E
vastgesteld
Verbinding met lezer - OK ]
Verbinding met lezer is niet correct B
Verbinding met lezer kan niet worden
vastgesteld.
Bedieningsmodus/ Symbool voor Symbool voor Symbool voor
deurstatus Normaal Permanent open Permanent
vergrendeld
Gesloten N E Ji
Normaal open Jl J‘ N.v.t.
Open met time-out Jl N.v.t. N.v.t.
Open onderbroken Jl N.v.t. Jl
Onbekend ol Ji Ji
Defect | | l l
Een verbindingsstoring wordt ook aangegeven door een balkje onder aan het dialoogvenster,
dat rood knippert bij het openen van het dialoogvenster.
201805 | |
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Connection to LAC 1, 2, 3, 4 out of order !

mud @

Bericht!

De statusweergave van Wiegand-kaartlezers kan misleidend zijn. Omdat een Wiegand-
kaartlezer niet kan reageren op statusverzoeken, wordt deze met gedefinieerde parameters
als online weergegeven zolang zijn controller online is.

Bedieningselementen
Deze functie is alleen beschikbaar als de aangemelde gebruiker deurbedieningsrechten heeft -

Gebruikersrechten, pagina 64.

Deze functie is alleen beschikbaar als de aangemelde gebruiker deurbedieningsrechten heeft.
Naar items die in de apparaatstatuslijst zijn geselecteerd en waarmee een verbinding tot stand
is gebracht, kunnen opdrachten worden verzonden via het snelmenu (klikken met de
rechtermuisknop) of het menu Door management (Deurbeheer).

Open Main entrance
Long-term apen Main entrance
lock Main entrance

De naam van het geselecteerde item wordt afgelezen in de context.

Open <Entrance> (Ingang De geselecteerde ingang gaat
openen) eenmaal open (om één persoon
door te laten).

Long-term open <Entrance> De geselecteerde ingang gaat

(Ingang langdurig openen) gedurende een langere tijd
open.

Lock <Entrance> (Ingang De geselecteerde ingang wordt

vergrendelen) vergrendeld.
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34 Online-kaartleesgegevens

Het contextmenu met de gegevens in de apparaatstatuslijst bevat tevens de functie Online
swipe (Online-kaartleesgegevens) waarmee een deelvenster rechts van het dialoogvensterveld
wordt geactiveerd.

In dit gedeelte toont de functie een historie van boekingen en berichten voor de geselecteerde
toegang. Van de laatste personen die hun kaarten hebben aangeboden bij een van deze
ingangslezers, worden de archiefbeelden, een tijdstempel en de beslissing m.b.t. de toegang
geregistreerd.

Bovendien worden eventuele meldingen die niet behoren tot de categorie Message (Melding)
of Information (Informatie) (behalve de meldingen 61-67), hier weergegeven met het symbool

| ]

De desbetreffende ingang wordt bovenaan het deelvenster weergegeven. Ook als u een andere
ingang selecteert uit de apparaatstatuslijst, blijft de Online swipe (Online-kaartleesgegevens)
weergave voor de eerste ingang bewaard. Als u voor een andere ingang wilt omschakelen naar
de Online swipe-weergave, moet u deze expliciet oproepen via het contextmenu voor die
ingang

Zolang het contextmenu actief is, bevat het de regel switch off online swipe (Online swipe
uitschakelen), zodat de toegangshistorie op elk moment weer kan worden verborgen.
Opmerkingen in kleur geven altijd aan of de toegang werd verleend (groen) of geweigerd
(rood).

pr——
P s 43044
L
I
o i
w7 t44108
Pt

Alleen de laatste 5 meldingen en/of boekingen worden getoond.

Wanneer de Online swipe-weergave (online-kaartleesgegevens) actief is, wordt het display
steeds bijgewerkt met nieuwe meldingen, waarvan de meest recente bovenin verschijnen.
De lijst bevat alleen toegangsaanvragen voor de huidige en de vorige dag. Als er gedurende
deze periode geen kaarten werden geregistreerd, blijft de lijst leeg.

3.5 Videobeheer

De videocomponenten die worden geleverd bij het Access Professional Edition

toegangscontrolesysteem kunnen worden gebruikt als extra beheerfaciliteit voor speciale

ingangen, met als doel live-beelden te vergelijken met beelden die zijn opgeslagen in een

database en zo de omgeving te controleren. Het is ook mogelijk om speciale reacties op het

alarm te genereren met behulp van video-opnamen en om specifieke omgevingen te bewaken,

zelfs onafhankelijk van ingangen.

Daarnaast kunnen videocomponenten worden opgeroepen en gebruikt in Access PE in de

volgende gebieden.

- Videoverificatie: extra optische controlefuncties bij ingangen

—  Alarmbeheer: speciaal geconfigureerde alarmmeldingen en ingangen kunnen worden
ondersteund door opgenomen videosequenties

- Videospecifieke weergaven: afspelen van huidige camerabeelden van maximaal vier
gelijktijdig vrij te configureren camera's
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3.5.1

Zie ook
- Video panel (Videopaneel), pagina 27
- Live-beeld, pagina 28

Video panel (Videopaneel)

(Videopaneel) Druk op de knop E in de werkbalk Personnel Management
(Personeelsbeheer) om het dialoogvensterveld te vervangen door een weergave met vier
video-beelden.

[172.18.1.38 1] lI,PgJEEIJ_FEJ [camera apE [1] ;Iféjfsj&]

2wl | 2 2l el

Camera configuration |

In het videopaneel kunt u maximaal vier camera's van verschillende ingangen selecteren.
De volgende functies zijn beschikbaar voor elk displayvenster.

Selectielijst U kunt een willekeurige camera selecteren
om in het toegangscontrolesysteem te laden
en deze op elk gewenst moment vervangen.

&] Slaat een momentopname van het actuele
beeld op als <device
name>_yyyyMMddhhmmsstttt.jpg in C:
\BOSCH\Access Professional Edition\PE
\Data\Video (standaardpad).

E.El Start/beéindigt een video-opname van het
actuele beeld en slaat het op als <device
name>_yyyyMMddhhmmsstttt.vxx in C:
\BOSCH\Access Professional Edition\PE
\Data\Video (standaardpad).
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3.5.2

E (= Point of Interest (Interessepunt)) Slaat
een momentopname van het actuele beeld
op — POI_ wordt toegevoegd aan het begin
van de bestandsnaam.

Er wordt ook een logboekbericht gemaakt
als markering.

Beelden voor videoweergave aanpassen

Een bepaalde selectie en rangschikking van camera's kan worden opgeslagen en vervolgens
later op naam worden opgeroepen. Dit bespaart tijd die anders zou zijn besteed aan het
handmatig selecteren en configureren van dezelfde weergave.

Configureer eerst handmatig de gewenste weergave door de camera's in de vensters te
positioneren die u het best uitkomen.

Geef de weergave vervolgens een betekenisvolle naam in de onderste keuzelijst en sla deze
naam op door op ENTER te drukken. Deze weergaven kunnen naderhand worden opgevraagd
met de naam uit dezelfde keuzelijst.

Op die manier kunnen operators verschillende cameraweergaven voor verschillende
doeleinden opslaan, bijv. om 's morgens binnenkomend en 's avonds vertrekkend personeel te
bewaken. Opgeslagen weergaven behoren bij het werkstation en niet bij de individuele
operator. Ze kunnen niet als zodanig worden bewerkt. Als u een weergave wilt wijzigen, roep
deze dan eerst op uit de keuzelijst, wis de naam met de

knop X rechts naast de keuzelijst, wijzig de camerastand, indien nodig, en sla die dan op
onder dezelfde naam als eerder is gebruikt, met behulp van de ENTER-toets.

Opgeslagen weergaven zijn specifiek voor een werkstation, niet voor een operator. Operators
kunnen dus door hun collega's aangepaste weergaven gebruiken.

Live-beeld
Behalve de deurbesturingsfuncties bevat het pop-upmenu dat ingangen en lezers in de
apparaatstatuslijst aangeeft, ook items om te verbinden met live-beelden.

md @

Bericht!
Deze functies zijn niet beschikbaar in de apparaatstatuslijst in de LogViewer.

Er is een algemeen item voor elke geconfigureerde camera toegevoegd aan deze toegang. Als
het maximale aantal camera's geconfigureerd is, verschijnt het pop-upmenu voor de modus
Live image (Live-beeld) als volgt:

— Identificatiecamera

—  Camera achteringang 1

—  Camera achteringang 2

-  Camera vooringang 1

-  Cameravooringang 2

Wanneer u een camera selecteert, verschijnt het live-beeld op het display. Als u geen
personeelsrecord hebt geselecteerd, wordt het live-beeld weergegeven in het
dialoogvensterveld (in plaats van de tijd). Anders verschijnt het in een kleiner formaat rechts
van de apparaatstatuslijst.
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Device states | e Video de
== | reas | Video devices | EEE

B[P, Access point
~fE] Access control reader
B[l st owr right
[} Entry reader 1
Exit reader 1
=[] 1stfioor left
. - Entry reader 1
[ Exit reader 1
=[] RS
-5} Access control reader

Als u een personeelsrecord selecteert om te bewerken terwijl het grote live-beeld wordt
weergegeven, schakelt de modus Live image (Live-beeld) naar een kleiner formaat.

Als de functie voor live-beelden voor een van de camera's actief is, bevat het popup-menu het
item Video off (Video uit) dat u kunt gebruiken om de standaardstatus te herstellen.

mud 0

Bericht!
U kunt ook modus Live image (Live-beeld) activeren via de cameralijst op het tabblad Video
devices (Video-apparaten) door het gewenste lijstitem te selecteren.

3.6

3.6.1

Videobeheer

De videocomponenten die worden geleverd bij het Access Professional Edition

toegangscontrolesysteem kunnen worden gebruikt als extra beheerfaciliteit voor speciale

ingangen, met als doel live-beelden te vergelijken met beelden die zijn opgeslagen in een

database en zo de omgeving te controleren. Het is ook mogelijk om speciale reacties op het

alarm te genereren met behulp van video-opnamen en om specifieke omgevingen te bewaken,

zelfs onafhankelijk van ingangen.

Daarnaast kunnen videocomponenten worden opgeroepen en gebruikt in Access PE in de

volgende gebieden.

— Videoverificatie: extra optische controlefuncties bij ingangen

—  Alarmbeheer: speciaal geconfigureerde alarmmeldingen en ingangen kunnen worden
ondersteund door opgenomen videosequenties

— Videospecifieke weergaven: afspelen van huidige camerabeelden van maximaal vier
gelijktijdig vrij te configureren camera's

Zie ook
—  Video panel (Videopaneel), pagina 29
- Live-beeld, pagina 31

Video panel (Videopaneel)
(Videopaneel) Druk op de knop E in de werkbalk Personnel Management

(Personeelsbeheer) om het dialoogvensterveld te vervangen door een weergave met vier
video-beelden.
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172.18.1.38 1]

LI.E!.JE’J.@ [camera ap 1

= ml ol

=) B o] B

= ml ol

Camera configuration |

1 |

In het videopaneel kunt u maximaal vier camera's van verschillende ingangen selecteren.
De volgende functies zijn beschikbaar voor elk displayvenster.

Selectielijst

&l

b=

U kunt een willekeurige camera selecteren

om in het toegangscontrolesysteem te laden

en deze op elk gewenst moment vervangen.

Slaat een momentopname van het actuele
beeld op als <device
name>_yyyyMMddhhmmsstttt.jpg in C:
\BOSCH\Access Professional Edition\PE
\Data\Video (standaardpad).

Start/beéindigt een video-opname van het
actuele beeld en slaat het op als <device
name>_yyyyMMddhhmmsstttt.vxx in C:
\BOSCH\Access Professional Edition\PE
\Data\Video (standaardpad).

(= Point of Interest (Interessepunt)) Slaat
een momentopname van het actuele beeld
op — POI_ wordt toegevoegd aan het begin
van de bestandsnaam.

Er wordt ook een logboekbericht gemaakt
als markering.

Beelden voor videoweergave aanpassen
Een bepaalde selectie en rangschikking van camera's kan worden opgeslagen en vervolgens
later op naam worden opgeroepen. Dit bespaart tijd die anders zou zijn besteed aan het

handmatig selecteren en configureren van dezelfde weergave.

2018-05 | |

APE-Personnel Management

Bosch Access Systems GmbH



Access Professional Edition Personnel Management (Personeelsbeheer) | nl 31

3.6.2

Configureer eerst handmatig de gewenste weergave door de camera's in de vensters te
positioneren die u het best uitkomen.

Geef de weergave vervolgens een betekenisvolle naam in de onderste keuzelijst en sla deze
naam op door op ENTER te drukken. Deze weergaven kunnen naderhand worden opgevraagd
met de naam uit dezelfde keuzelijst.

Op die manier kunnen operators verschillende cameraweergaven voor verschillende
doeleinden opslaan, bijv. om 's morgens binnenkomend en 's avonds vertrekkend personeel te
bewaken. Opgeslagen weergaven behoren bij het werkstation en niet bij de individuele
operator. Ze kunnen niet als zodanig worden bewerkt. Als u een weergave wilt wijzigen, roep
deze dan eerst op uit de keuzelijst, wis de naam met de

x

knop rechts naast de keuzelijst, wijzig de camerastand, indien nodig, en sla die dan op
onder dezelfde naam als eerder is gebruikt, met behulp van de ENTER-toets.
Opgeslagen weergaven zijn specifiek voor een werkstation, niet voor een operator. Operators

kunnen dus door hun collega's aangepaste weergaven gebruiken.

Live-beeld
Behalve de deurbesturingsfuncties bevat het pop-upmenu dat ingangen en lezers in de
apparaatstatuslijst aangeeft, ook items om te verbinden met live-beelden.

mud 0

Bericht!
Deze functies zijn niet beschikbaar in de apparaatstatuslijst in de LogViewer.

Er is een algemeen item voor elke geconfigureerde camera toegevoegd aan deze toegang. Als
het maximale aantal camera's geconfigureerd is, verschijnt het pop-upmenu voor de modus
Live image (Live-beeld) als volgt:

- Identificatiecamera

—  Camera achteringang 1

—  Camera achteringang 2

—  Camera vooringang 1

— Camera vooringang 2

Wanneer u een camera selecteert, verschijnt het live-beeld op het display. Als u geen
personeelsrecord hebt geselecteerd, wordt het live-beeld weergegeven in het
dialoogvensterveld (in plaats van de tijd). Anders verschijnt het in een kleiner formaat rechts
van de apparaatstatuslijst.

;ﬁ:ms | Areas. | Video devices | E E E

B[, Access point

B Access control reader
& [l st four right

[ Eniry reader 1

-} Extt reader 1
&[] 1stfloorleft

S Entry reader 1

Bt Exit reader 1
=1 EECi

5t Access control reader

Als u een personeelsrecord selecteert om te bewerken terwijl het grote live-beeld wordt
weergegeven, schakelt de modus Live image (Live-beeld) naar een kleiner formaat.

Als de functie voor live-beelden voor een van de camera's actief is, bevat het popup-menu het
item Video off (Video uit) dat u kunt gebruiken om de standaardstatus te herstellen.
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Bericht!

[

U kunt ook modus Live image (Live-beeld) activeren via de cameralijst op het tabblad Video
l devices (Video-apparaten) door het gewenste lijstitem te selecteren.
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4 Personnel data (Personeelsgegevens)

Als u een nieuwe persoon wilt toevoegen, opent u een leeg dialoogvenster met de knop
of via het menu Persons > New person (Personen > Nieuwe persoon).

Bericht!
Deze procedure geldt voor het maken van een nieuwe personeelsrecord. Als u echter
bestaande personeelsgegevens wilt bewerken, dubbelklikt u op een persoon in de

Jﬁ . Hetzelfde

dialoogvenster wordt geopend maar in dat geval bevat het de gegevens van de geselecteerde
persoon.

mud 0

personeelslijst, of selecteert u een persoon en klikt u op de werkbalkknop

Personnel data and authorizations x

% Additional Data | i- Offline Access Authorizations
X Personnel Data | [l Access Authorizations | €] User Rights

— Person r— Personnel group
Take picture |
Tite ] | =
Last name I Preview card |
First name I ~Card data Print card |
E Person has no card assigned Print card reverse side |

Company Personnel-No. I

Import picture

'I.Card-No.I Version ID = —l
Delete picturs

Phone | 2. Card-No. I Version [0 =+ —l

Date of birth

Lk

1=
Vai from | I und = 3Cado [ Veson [0 = Acknowledgement |
— Special function
Assign card 1 |
[™ Pemission to long-temm open of doors (Office mode) rAccess control data
™ Activate control function 1 Assign card 2 |
[~ Activate control function 2 Time: model I |
Assign card 3
— Special on the reader PIN Corfim PIN

Mame on display | NeTcstion I— l— il iI Delete card 1 |

On amival I Identification I I il ll Delste card 2 |
On leaving | Delete card 3 |

QK I Cancel Help
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4.1 Personeels- en kaartgegevens

Het dialoogvenster Personal data and authorizations (Personeelsgegevens en autorisaties)

bevat alle relevante persoonlijke en kaartgegevens, evenals speciale kaartinformatie. U moet

ten minste een naam en een personeelsgroep voor de persoon opslaan in de database.

De volgende informatie kan worden opgeslagen:

Gegevensveld/ |Beschrijving

Invoerveld

Person

(Persoon)

Title (Titel) Deze gegevens verschijnen hier in de
volgorde Title (Titel), First name

Last name v ) L ast (Acht )

ast name (Achternaam). In

(Achternaam) oornaam en ) J
de personenlijst wordt de titel niet

First name weergegeven.

(Voornaam)

Date of birth De datum kan met cijfers worden ingevoerd

(Geboortedatu |of met behulp van de kleine pijlknoppen

m) worden geselecteerd.

Bedrijf Het bedrijf of de afdeling mag 4 regels lang
zijn. U kunt een regeleinde invoeren met
behulp van Ctrl + ENTER. Max. 114 tekens.

Telephone Wordt ook weergegeven bij de informatie

(Telefoon) over de beschikbaarheid van de persoon.
Max. 30 tekens.

Valid from ... Geef hier de geldigheidsperiode op voor

to ... (Geldig toegangscontrole. Als u de velden leeg laat,

van ... tot ...) is de geldigheid oneindig.

Personnel Invoer vereist. U moet een personeelsgroep

group kiezen.

(Personeelsgro

ep)

Card data (Kaartgegevens)

(Display of card | De huidige kaartstatus wordt met een

status) symbool weergegeven.

(Weergave van IE

kaartstatus) Geen kaart toegewezen
IE' Kaart toegewezen

Personnel-No. |Voer een personeelsnummer van max. 6

(Personeelsnr.) |cijfers in.
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Gegevensveld/
Invoerveld

Beschrijving

1. Card No.
(Kaartnr.)

Voer een kaartnummer van max. 6 cijfers in.
Voor alle kaarten gelden dezelfde

2. Card No.
(Kaartnr.)

toegangsautorisaties.

3. Card No.
(Kaartnr.)

Speciale functie

Toestemming
voor langdurig
openen van
deuren
(kantoormodus

)

Autorisatie verlenen voor het gebruik van de
Kantoormodus bij de respectieve
geconfigureerde deuren (zie de
configuratiehandleiding).

Besturingsfunct
ie 1 activeren

Besturingsfunctie 1 wordt opgeroepen bij
de respectieve geconfigureerde lezer.

Besturingsfunct
ie 2 activeren

Besturingsfunctie 2 wordt opgeroepen bij
de respectieve geconfigureerde lezer.

Special messages on the reader (Speciale berichten op de

lezer)

Display name
(Weergavenaa
m)

Displaytekst voor kaartlezers die over deze
functie beschikken. Standaard worden de
voor- en achternaam weergegeven. Max. 20
tekens.

Text on arrival
(Tekst bij
aankomst)

Text on
departure
(Tekst bij
vertrek)

Voor TA-lezers kunt u hier aangepaste
teksten invoeren die worden weergegeven
wanneer de persoon arriveert en vertrekt.
Hiervoor moet de systeemparameter Show
welcome/leaving message (Welkomst-/
vertrekbericht weergeven) zijn geactiveerd
in de Configurator-instellingen. Max. 20
tekens.

Access control data (Toegangscontrolegegevens)

Time model
(Tijdmodel)

Selecteer een bestaand tijdmodel. De
persoon heeft alleen toegang tijdens de
gedefinieerde perioden.

Bosch Access Systems GmbH
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Gegevensveld/
Invoerveld

Beschrijving

PIN

Invoer van PIN's voor gebruik met de lezers
met codeklavier. PIN's mogen geen reeksen
(bijv. 1234) of palindromen (bijv. 0110)
bevatten. Algemene instellingen worden
geconfigureerd in het dialoogvenster
Configurator > Settings (Instellingen).

Verification +
Confirmation
PIN (Verificatie
+ bevestigen
PIN)

Deze PIN kan automatisch worden

gegenereerd

— door het systeem of

- worden ingevoerd als een 4 tot 8
cijferige PIN (standaard = 4) in. Deze
wordt als extra beveiligingsmaatregel
gevraagd na het tonen van de kaart bij
een ingang.

Identificatie-
PIN/ ID-PIN

Deze PIN moet uniek zijn in het gehele

systeem. Deze kan automatisch worden

gegenereerd

— door het systeem of

— worden ingevoerd als een 4 tot 8
cijferige PIN (standaard = 4) in. Deze
wordt als extra beveiligingsmaatregel
gevraagd na het tonen van de kaart bij
een ingang.

De identificatie-PIN wordt voér het opslaan

weergegeven in een berichtvenster.

Personalverwaltung @

-

l'-: The new PIM is: 7392

Deze ID-PIN kan worden ingevoerd op lezers
met codeklavier in plaats van een kaart te
tonen. Aangezien deze PIN functioneert als
kaartnummer, bevat deze ook alle
autorisaties die aan dat kaartnummer zijn
toegewezen.
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Gegevensveld/ |Beschrijving
Invoerveld

Activerings- Voer een 4-8 cijferige PIN (standaard = 4,
PIN / IDS-PIN met dezelfde lengte als de verificatie-PIN) in
voor activering van het alarmsysteem.

Of deze velden al dan niet worden
weergegeven, stelt u in met het
selectievakje separate IDS-PIN (aparte IDS-
PIN) (Configurator > Settings) (Configurator
> Instellingen).

Wanneer u de velden standaard instelt voor
in-/uitschakelen van het alarm, worden de
IDS (inbraakdetectiesystemen) niet
weergegeven.

Als er geen aparte activering-PIN is
ingesteld, kan er een verificatie-PIN worden
gebruikt voor activering van het IDS. Als er
echter een aparte activerings-PIN is
ingesteld, kan alleen deze worden gebruikt -
de verificatie-PIN werkt in dat geval niet als
activering-PIN.

Opmerking: een vierde variant op de PIN, de Door-PIN (deur-
PIN) kan apart worden toegewezen aan individuele deuren.
ledereen die gebruikt maak van deze deur, moet deze code
kennen.

Deur-PIN's worden ingesteld en geactiveerd in de
configurator op de pagina Entrances (Ingangen) onder de
functie PIN or Card (PIN of kaart).

Belangrijk: tijdens het gebruik van Wiegand controllers en
lezers moet, om de identificatie-, activering- of deur-PIN's te
kunnen gebruiken, de Wiegand-kaartdefinitie PIN or Card
(PIN of kaart) (nr. 6) worden geactiveerd.

Knoppen aan de rechterkant van het dialoogvenster
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Gegevensveld/
Invoerveld

Beschrijving

Take picture
(Foto maken)

Preview card
(Voorbeeld
kaart)

Print card
(Kaart
afdrukken)

Print card
reverse side
(Achterkant van
kaart
afdrukken)

Acknowledgem
ent
(Bevestiging)

Deze knoppen zijn alleen zichtbaar wanneer
Card Personalization (CP) (Kaarten maken,
pagina 46) op dit werkstation is
geinstalleerd en is geopend.

Import picture
(Foto
importeren)

U kunt foto's met de indeling .jpg of .bmp
importeren. De foto wordt in de weergave
van personeelsgegevens geintegreerd.

Delete picture
(Foto
verwijderen)

Deze optie is alleen beschikbaar als een
foto is geimporteerd.

Delete card 1
(Kaart 1
verwijderen)

Delete card 2
(Kaart 2
verwijderen)

Delete card 3
(Kaart 3
verwijderen)

Deze optie is alleen beschikbaar als een
kaart is toegewezen. Hiermee wijzigt u de
weergave van de kaartstatus (zie het
bovenstaande).

Assign card 1
(Kaart 1
verwijderen)

Assign card 2
(Kaart 2
toewijzen)

Assign card 3
(Kaart 3
toewijzen)

Hiermee wijst u de geselecteerde persoon
een kaartnummer toe en wijzigt u de
weergave van de kaartstatus (zie het
bovenstaande).
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Bericht!
De identificatie en de deur-PIN-varianten kunnen niet worden gebruikt voor deurmodellen met
activering van het beveiligingssysteem (TM 10 en 14).

4.2

Kaarten toewijzen en intrekken

ledere kaarthouder kan beschikken over maximaal drie kaarten, die afzonderlijk kunnen
worden toegewezen en ingetrokken. Afhankelijk van de configuratie van het systeem kunnen
kaartgegevens handmatig of via een registratielezer worden opgeslagen. Er kan echter slechts
één van deze methoden tegelijkertijd actief zijn: zodra een registratielezer is geconfigureerd
(Tools > Properties (Tools > Eigenschappen)), kan er niet langer handmatig worden
opgeslagen.

Handmatige gegevensopslag ondersteunt het gebruik van verschillende kaarttechnologieén,
doordat de gebruiker in staat wordt gesteld de onderliggende kaartbitformaten te wijzigen.
Wanneer er echter een registratielezer wordt gebruikt, kunnen alleen kaarten van dezelfde
onderliggende kaarttechnologie worden gebruikt.

mud @

Bericht!

In Access PE kan een kaarthouder meerdere ID-gegevens in meerdere formaten en
technologieén gebruiken. Met elk van deze ID-gegevens wordt echter dezelfde persoon met
dezelfde set autorisaties, blokkeringen, PIN's, tijdmodellen en gebiedsbeperkingen
geidentificeerd.

Kaarten kunnen handmatig of met een lezer worden gecontroleerd, afhankelijk van de
eigenschappen (Registratieconfiguratie, pagina 14). Beide modi kunnen niet tegelijk actief zijn.
Zodra een lezer is geconfigureerd, kan het kaartnummer niet meer handmatig worden
ingevoerd.

Kaarten handmatig invoeren

Als u de kaarten handmatig wilt invoeren, moeten een kaartnummer met maximaal zes cijfers
en ten minste de minimale personeelsgegevens in de naam- en personeelsgroep zijn
gedefinieerd. Voer een geldig kaartnummer in voor de persoon!

Klik op Assign card (Kaart toewijzen) om te controleren of het kaartnummer uniek is. Deze
kaart is reeds toegewezen aan de volgende persoon: xxx

Het kaartnummer wordt nu gecodeerd op basis van de standaard kaartgegevens in het
dialoogvenster General Settings (Algemene instellingen) van Access PE Configurator. Wanneer
het toewijzen is voltooid, verschijnt een bevestigingsvenster. Klik in dit venster op OK om de
gegevens op te slaan.
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Personnel data and authorizati
% Additional Data | r Offline Access Authonzations
X Personnel Data | [l Access Authorizations | [=®] User Rights
— Person r— Personnel group
Take picture |
Title | |Emplwees =
Last name Iﬂzna\rour FeLErEd |
First name IBrian [ Card data Print card |
Date of birth I = E S Print card reverse side |
Company Personnel-No. I
Import picture |
1. Card-No. I Version ID =
Delete picture
Phone | 2 Card-o. | Version [0 = —l
. — 4 —
Valid from I = until I = 9 Card-No. l— e IG e — |
r— Special function
Assign card 1 |
[~ Pemission to long-tem open of doors (Office mods) r~Access control data
™ Activate control function 1 Assign card 2 |
™ Activate control function 2 Time model I LI
Assign card 3
r~ Special messages on the reader PIN Corfirm PIN
Delete card 1 |
Name on display I Verification I I +| ll e
On leaving I Delete card 3 |
I Card successful assigned ! I
OK | Apbrechen | Hife |

Als Connect to LAC Service (Verbinden met LAC-service) in Personnel Management
properties (Eigenschappen personeelsbeheer, Registratieconfiguratie, pagina 14) is
ingeschakeld, worden wijzigingen in of toevoegingen aan personeelsgegevens onmiddellijk
naar de LAC-service verzonden en worden ze van kracht in het hele systeem.

Bericht!
Aan een persoon moeten niet alleen een kaartnummer maar ook de autorisaties
(Authorizations (Autorisaties), pagina 41) voor alle vereiste ingangen worden toegewezen.

md 0

Als het selectievakje Do not show dialog for editing card information (Dialoogvenster voor
bewerken van kaartgegevens niet weergeven) niet is ingeschakeld in Personnel Management
properties (Eigenschappen personeelsbeheer), opent u met de knop Assign card (Kaart
toewijzen) het volgende dialoogvenster, waarin u de standaardinstellingen kunt annuleren (zie
Access PE Configurator).
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4.3

o o

Internal Card Information @
Cuztomer code Country code
B IP‘TIEI::I-:L.JE:E:IEn:ima | aB7el B Ihr-:al::l-:L.Jatu:IEu:imal I_D
Card code
I IP‘|n|3l::l-:L.JE|t|:|En:imal 106 WEEI I_D

Don't show thiz dialog again.
Generate card code with predefined data.

Azzign card Cancel ‘

Kaart aanleren met dialooglezer

Als u een dialooglezer voor het inlezen van kaarten wilt aansluiten, moet u deze configureren
in Personnel Management Properties (Eigenschappen personeelsbeheer). In dat geval wordt
het handmatig aanleren automatisch uitgeschakeld.

In dit geval worden alle gegevens vanaf de kaart ingelezen. Het gebruik van toetsen is niet
nodig en wordt door het systeem genegeerd.

De gebruiker wordt gevraagd zijn of haar kaart voor de dialooglezer te houden, waarna de
gebruiker toegang wordt geboden of een foutmelding verschijnt.

Authorizations (Autorisaties)

Deze pagina verschijnt alleen als de gebruiker zich heeft aangemeld met beheerdersrechten
(Gebruikersrechten, pagina 64) om autorisaties te wijzigen.

Met de opties van dit tabblad kunnen autorisaties worden toegewezen aan personen in het
toegangscontrolesysteem. Als Configurator (dialoogvenster Authorization groups)
(Autorisatiegroepen) al is gebruikt voor het toewijzen van standaardautorisaties aan specifieke
personeelsgroepen, beschikt de betreffende persoon al over de autorisaties omdat hij/zij lid is
van de personeelsgroep.

Default authorization
far perzonnel group

Employees j

Met de opties van dit tabblad kunnen de autorisaties van de gebruiker echter worden
aangevuld.
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Personnel data and authorizations @

1 Personnel Data I'I Access Authonzations |E| User Rights % Additional Data |

Group authorizations

Authorization for groups W alid from | Walid until | MO authorization for groups |
+ ButhiGroup

<

pl 21

Avtharizations for zsingle entrances

Autharization for “alid from " alid Ll | MO autharization for
+ Access point

bl 2L

>

Ok Abbrechen Hilfe

Dit dialoogvenster bevat vier lijsten. De lijsten aan de rechterkant bevatten alle
geconfigureerde autorisatiegroepen (bovenste lijst) en alle geconfigureerde individuele
ingangen (onderste lijst). De totale autorisaties van een persoon bestaan uit alle
autorisatiegroepen en alle individuele ingangen die hem/haar in dit dialoogvenster worden
toegewezen.

Autorisaties (groepen of ingangen) kunnen aan een persoon worden toegewezen door in een
lijst aan de rechterkant op een autorisatie te dubbelklikken, of door een autorisatie te

selecteren en op g te klikken. Met de knop ﬁ worden alle beschikbare autorisaties
tegelijk toegewezen. U kunt een willekeurige combinatie van groepsautorisaties en individuele
autorisaties toewijzen. Toegewezen autorisaties kunnen worden ingetrokken door erop te

dubbelklikken, of met behulp van de knoppen _}l en ﬂ

Als autorisatiegroepen tijdmodellen bevatten (normaal gesproken zijn deze
dienovereenkomstig benoemd), mogen de ingangen die aan de groep zijn toegewezen, alleen
tijdens de betreffende tijdmodellen door die persoon worden gebruikt. Let op de speciale
gevallen in Application of time models *** XRef ME TO Anwendung_von_Zeitmodellen.xml in
Access PE.

Autorisaties zijn weliswaar standaard niet in de tijd beperkt, maar het is mogelijk om zowel
groeps- als individuele autorisaties te beperken door datums in te voeren in de kolommen
valid from (geldig van) en valid to (geldig tot). Wanneer u in deze kolommen op een cel klikt,

wordt de in-line editor voor het invoeren van datums en tijden geopend:
B . : |

Datums kunnen via het toetsenbord of de muis worden ingevoerd met behulp van de kleine
pijlknoppen aan de rechterkant van de editor. Met de spatiebalk verplaatst u de cursor van
dag naar maand naar jaar, enzovoort. Door met de rechtermuisknop op een open datumveld te
klikken, kunt u een kalenderkiezer openen voor extra snelheid en comfort.
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4.4

4 | Oktober 2016 »
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3Heute: 14.10.2016

Op die manier kunt u bij het creéren van een persoon autorisaties toewijzen die pas op een
latere datum in werking treden. Daarom is het niet nodig een herinnering in te stellen om de
autorisaties van een persoon aan te passen omdat u ze automatisch op een bepaalde datum
kunt laten vervallen. Als een valid from-datum (geldig vanaf) na een valid to-datum (geldig tot)
komt, wordt de autorisatie uitgeschakeld wanneer de valid to-datum wordt bereikt, en
opnieuw ingeschakeld wanneer de valid from-datum wordt bereikt. Dit is handig wanneer een
persoon bijvoorbeeld met vakantie gaat.

Wijzigingen in autorisaties en andere personeelsgegevens worden pas opgeslagen wanneer u
ze bevestigt door op OK te klikken. Op dat moment worden alle wijzigingen automatisch naar
de controllers verzonden, mits in Settings (Instellingen) (Tools > Properties) (Tools >
Eigenschappen) de optie Connect to LAC Service (Verbinden met LAC-service) is
ingeschakeld. In speciale gevallen kunnen de gegevens handmatig worden verzonden met de
menuopdracht Persons > Transmit selected person to LAC service (Personen >
Geselecteerde persoon naar LAC-service verzenden) of Persons > Transmit all persons to LAC
service (Personen > Alle personen naar LAC-service verzenden).

Extra velden

Dit tabblad is alleen zichtbaar wanneer ten minste een van de tien beschikbare velden voor
aanvullende gegevens is geconfigureerd in Access PE Configurator.

U kunt maximaal tien velden voor aanvullende gegevens configureren. Zowel het aantal als de
naam van deze velden kan variéren. De velden kunnen maximaal 40 tekens bevatten.

De velden worden in volgorde weergegeven. Als een van de tien velden wordt overgeslagen,
wordt een spatie weergegeven als tijdelijke aanduiding. Als het betreffende veld later wordt
geconfigureerd, vervangt het de tijdelijke aanduiding in de lijst.
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Personnel data and authorizations @
X Personnel Data | [ Access Authorizations | el User Rights Z¥ Additional Data |
Marne of hirth ||
Marital status |

Phone - private |

Fhone - private [mobile) |

Size

Ok | Abbrechen Hilfe

Voorzichtig!

Aan elk tekstveld wordt een veld in de database toegewezen, zodat de gegevens kunnen
worden opgeslagen, geselecteerd en in rapporten opgenomen. Dit betekent echter dat door
wijzigingen in extra gegevensvelden die in gebruik zijn, de gegevens uit de database verloren
zullen gaan. De naam van een veld voor aanvullende gegevens kan op elk ogenblik worden
gewijzigd, mits het type inhoud van het veld niet wordt gewijzigd.

4.5

Tijdmodellen toepassen

Tijdmodellen die zijn toegewezen aan personeelsgegevens, zijn alleen actief als de
standaardinstellingen van de lezer niet zijn gewijzigd, m.a.w. als de optie No time model
check (Geen controle tijdmodel) uitgeschakeld blijft.

Aangezien tijdmodellen op vele manieren kunnen worden gebruikt, moet u de volgende
conflictoplossingsregels in acht nemen om te begrijpen hoe het systeem met meerdere
toewijzingen werkt:

Als een persoon via een tijJdmodel toegang heeft tot bepaalde ingangen en die persoon nu
zonder tijdmodel toegang krijgt tot dezelfde ingangen, geldt de minst strikte beperking. Dit
betekent dat in dit geval het tijJdmodel niet wordt toegepast.

Voorbeeld:

Aan een persoon worden de volgende toegangsrechten toegewezen:

— Toegang tot ingang A, B, C en D binnen het tijdmodel van 09:00 tot 17:00, elke dag.

- Individuele toegangsrechten tot ingang B en D zonder tijdmodel.

Deze persoon heeft nu elke dag tussen 09:00 en 17:00 toegang tot ingang A en C, en heeft
onbeperkte toegang tot ingang B en D.
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— Als aan een persoon andere toegangsrechten voor dezelfde ingangen worden toegewezen
maar met toepassing van andere tijJdmodellen, wordt de combinatie van de tijdmodellen
toegepast.

Voorbeeld:

Aan een persoon worden de volgende toegangsrechten toegewezen:

- Toegang tot ingang A, B, C en D binnen het tijdmodel van 07:00 tot 13:00, elke dag.

— Toegang tot ingang B, D, E en F binnen het tijdmodel van 09:00 tot 17:00, elke dag.

Deze persoon heeft nu van 07:00 tot 13:00 toegang tot ingang A en C, van 07:00 tot 17:00

toegang tot B en D, en van 09:00 tot 17:00 toegang tot E en F.

—  Als een persoon aan een autorisatiegroep met tijdmodellen wordt toegewezen en aan
dezelfde persoon een tijdmodel met gebruik van zijn kaart wordt toegewezen, wordt het
snijpunt van de gedefinieerde perioden toegepast.

Voorbeeld:

Aan een persoon worden de volgende toegangsrechten toegewezen:

—  Een autorisatiegroep met toegang tot ingang A, B, C en D en een tijdmodel van 07:00 tot
13:00, elke dag.

—  Een autorisatiegroep met toegang tot ingang B, D, E en F en een tijJdmodel van 09:00 tot
17:00, elke dag.

- En daarnaast een tijdmodel van 11:00 tot 19:00, elke dag.

Deze persoon heeft nu van 11:00 tot 13:00 toegang tot ingang A en C, en van 11:00 tot 17:00

toegang tot B, D, Een F.
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5

Kaarten maken

Access PE wordt geleverd met een eigen kaartpersonaliseringsprogramma. U kunt deze
software naar keuze installeren op bepaalde computers. Om kaarten te personaliseren hebt u
ook de juiste hardware nodig (camera en printer). Wij raden daarom aan dat u deze
componenten alleen installeert op de computers die u gaat gebruiken voor het personaliseren
van kaarten.
Let op: zelf de beeldimportfunctie, bijvoorbeeld voor het weergeven van beelden in het
dialoogvenster Personnel (Personeel), werkt alleen op computers waarop het
kaartpersonaliseringsprogramma is geinstalleerd en gestart.

5.1 Kaarten maken
De functies voor het maken van kaarten kunnen worden uitgevoerd vanaf alle werkstations
waarop het programma Badge Designer is geinstalleerd en is geopend. Het tabblad Personnel
data (Personeelsgegevens) bevat de nodige knoppen hiervoor.
P I data and
% Additional Data r Offline Access Authonzations |
X Personnel Data [l Access Authorizations | [==) User Rights |
— Person — Personnel group
Take picture |
Title || IEranuyees LI
Last name Iﬂzna\rour felEoed | I
First name IBrian ~Card data Prirt card |
Date of birth I = E Card assigned Print card reverse side |
Company Personnel-No. I
Import picture
‘I.Card-No.I 1234 Version ID ::I‘ —l
Delete picture
Phone | 2. Cardo. | Version [0 = —l
Valid from | = untl | = 3CadNo. [ Vemon [0 = Acknowledgemert |
r— Special function
Assign card 1 |
[~ Pemission to long-tem open of doors (Office mods) r~Access control data
™ Activate control function 1 Assign card 2 |
[~ Activate control function 2 Time mode! I j ) |
Assign card 3
r~ Special messages on the reader PIN Corfirm PIN
Name on display IBrian Aznavour Verification I I illl ﬂl
On amival | Identification I I illl Delete card 2 |
On leaving I Delete card 3 |
QK I Abbrechen Hiffe:
Daarnaast moet de benodigde apparatuur zijn aangesloten op het werkstation: een camera en
een kaartprinter.
Als u de hardware wilt configureren, selecteert u de kaartpersonalisatieconfigurator.
Stel een camera of printer in met de ingangen op respectievelijk het tabblad Video of het
tabblad Print (Afdrukken). Raadpleeg ook de online Help van dit hulpprogramma.
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Card Personalization Konfiguration

Allgemein | Yideo | Scannen | fAnzeige | Drucken | Info | Idr | Kommunik.ation | B arrier |

Aktive Module
W vz - MICard Videodienzt

Trace-Lewvel 0] - [ Mssz - MICard Scandienst
¥ tds - MICard Anzeigedienst
[v Mps - MICard Druckdienst

Iv¥ Ohne Konsolenfenster

v )
B aiomelisesie i ¥ Miz - MICard Informationsdienst

v rm00a - Kommunik stionsdignst

=)

0K | Abbrechen

(bemehmen Hilfe

Het wordt aanbevolen de volgende procedure uit te voeren om kaarten te maken:

Foto importeren of maken

Afdrukvoorbeeld van kaart weergeven (optioneel)
Voor-/achterkant van kaart afdrukken
Ontvangstbewijs voor kaart afdrukken (optioneel)

5.2 Foto's maken of importeren

Foto's van personen, die op kaarten moeten worden afgedrukt of in het dialoogvenster met

personeelsgegevens moeten worden weergegeven, kunnen worden gemaakt met een
aangesloten camera of worden geimporteerd uit een bestand, indien beschikbaar.

Foto's importeren
Foto's kunnen als bestanden worden geimporteerd en aan personeelsgegevens worden

toegewezen.
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Bericht!

Foto's kunnen ook wanneer de toepassing Card Personalization niet is geinstalleerd, worden
geimporteerd op het werkstation. In dat geval kunnen de foto's echter alleen in het
oorspronkelijke formaat worden geimporteerd. De hieronder beschreven opmaakfuncties zijn
dan niet beschikbaar.

Als u een foto vanuit een bestand wilt importeren, klikt u op Import picture (Foto importeren)
en selecteert u het gewenste bestand in het dialoogvenster voor bestandsselectie. Via de
configuratie-instellingen voor het programma Card Personalization definieert u een standaard
map voor geimporteerde bestanden, die automatisch wordt geopend wanneer u de
importeerfunctie start. U kunt echter een willekeurig grafisch bestand op het systeem zoeken
en selecteren via het dialoogvenster voor bestandsselectie.

Wanneer u een bestand selecteert, wordt het weergegeven in het voorbeeldvenster zodat u
makkelijk de juiste foto kunt vinden.

Import @

-

Search i | Pictures j = c¥ Edv

Name) Datum Typ Grifte Markierun..,

f nooonnol 11052007, IPEG-Bild 194 KB

=1 Desert  14.03.2008.. JPEG-Bild 827 KB

= 000oQaoz  10.05.2007 .. JPEG-Bild 10 KB

=l 2_Hydr...  24.03.2008 .. JPEG-Bild 582 KB

= anony...  10.06.2009.. JPEG-Bild 5 KB

= doorew..  11.08.2000.. JPEG-Bild 25 KB

File name:  |00000001 Apply | V
File type: I.&II supparted graphic farmats ;I LCancel |

[
1240165324

Nadat u een foto hebt gekozen, verschijnt een opmaakvenster, waarin u de foto kunt bijsnijden
en verkleinen/vergroten. Het rode frame geeft het gedeelte van de foto aan dat in het systeem
wordt opgeslagen voor de desbetreffende persoon.
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o o

Zelect detail

ok Cancel |

U kunt het geselecteerde deel van de foto in het frame verplaatsen door het met de
linkermuisknop te verslepen.

Zelect detail

Cancel |

U kunt het geselecteerde deel van de foto ook vergroten door met de linkermuisknop te
klikken, de muisknop ingedrukt te houden en met de muis uit te rekken. Op die manier kunnen
zelfs kleine delen van een foto voor een kaart worden gebruikt, mits de resolutie van de foto
hoog genoeg is.

Klik op OK om het geselecteerde deel van de foto te importeren.
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P o

select detail

[n];8 Cancel |

De framegrootte wordt aangepast aan de grootte van het frame in het dialoogvenster en/of het
fotoframe in de gedefinieerde kaartlay-out, en daar weergegeven onmiddellijk nadat het
importeren is bevestigd.

Foto maken

De toepassing Card Personalization (CP) voor het maken van kaarten moet worden
geconfigureerd voor het cameratype dat op het werkstation is aangesloten. U doet dit via het
dialoogvenster CP Configuration (CP-configuratie). Raadpleeg het Help-bestand van de
toepassing voor meer informatie over de mogelijke instellingen.

De volgende schermafbeeldingen zijn gemaakt in Video for Windows maar zijn afhankelijk van
het cameratype dat u gebruikt.

Klik op de knop Take picture (Foto maken) om het volgende dialoogvenster te openen:

Video &

Ereeze | Spply | LCancel |

Indien nodig kunt u de huidige camera-instellingen controleren en wijzigen met de knop ﬂ
Als de instellingen correct zijn, kunt u het beeld stilzetten met de knop Freeze (Stilzetten).

U kunt de modus Live image (Live-beeld) op elk gewenst moment weer activeren in geval het
stilgezette beeld niet naar wens is. Als de foto voor kaarten en personeelsgegevens moet
worden gebruikt, klikt u op Apply (Toepassen).
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5.3

Het dialoogvenster Crop picture (Foto bijsnijden) wordt geopend. Met behulp van een
snijframe kunt u het deel van de foto selecteren dat u op de kaart wilt afdrukken.
Lees de paragraaf over foto's importeren hiervodr voor meer informatie over het snijframe.

Kaarten vooraf bekijken en afdrukken

De knoppen Preview card (Afdrukvoorbeeld van kaart) en Print card reverse side (Achterkant
van kaart afdrukken) zijn alleen actief als kaart-lay-outs zijn toegewezen aan de
overeenkomstige personeelsgroep in Access PE Configurator (dialoogvenster: Personnel
Groups (Personeelsgroepen))

Card layout

Front iTelealdﬁEN v!

Reverse |Back_EN w

Preview card (Voorbeeld kaart)

Nadat de foto is gemaakt, wordt deze automatisch in de vooraf gedefinieerde zone van de
kaart-lay-out ingevoegd, zodat u de kaart kunt bekijken voordat deze wordt afgedrukt. U
bekijkt het voorbeeld van de kaart in het volgende dialoogvenster, dat u oproept met de knop
Preview card (Afdrukvoorbeeld van kaart).

= Badge format 474 x 297 mm El

&) BOSCH

Name:

Public

First name:
Samantha B.

Personnel no. 75657

Sluit het dialoogvenster door te klikken op OK

Print card (Kaart afdrukken)

Als de lay-out van de kaart naar wens is, kunt u de kaart bij de laatste stap afdrukken. Met de
knop Print card (Kaart afdrukken) roept u het volgende dialoogvenster op, dat identiek is aan
het vorige, behalve dat het ook een afdrukopdracht bevat.
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= Badge format 474 x 297 mm

@) BOSCH

Name:

Public

First name:
Samantha B.

Personnel no.: 75657

Als u het afdrukken wilt starten, klikt u op de knop Print (Afdrukken) om een dialoogvenster te
openen waarin u printer kunt selecteren. Als een standaardprinter is gedefinieerd in
Configurator, wordt het afdrukken onmiddellijk gestart.

Frint badge
Prnter: | ~ | Erint
# copies: |1 LCancel

Print card reverse side (Achterkant van kaart afdrukken)

Als de achterkant van de kaart moet worden afgedrukt, kunt u hiervoor een speciale lay-out en
inhoud definiéren.

Let op: zorg dat de kaarten waarvan de voorkant al is afgedrukt, bovenaan in de papierlade
van de kaartprinter liggen voordat u de opdracht voor het afdrukken van de achterkant kiest.
Tip: wij raden u aan alleen algemene en geen persoonsgegevens op de achterkant af te
drukken. Hierdoor kunt u de achterkant van een groot aantal kaarten vooraf afdrukken en op
voorraad houden. Dit versnelt het maken van complete kaarten voor individuele personen
wanneer nodig.

X

= Badge format 474 x 297 mm

For example here you can place

important notes for the card holder.

LCancel
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5.4 Ontvangstbewijzen voor kaarten afdrukken

Een andere functie van de toepassing voor het maken van kaarten is de mogelijkheid om een
standaard ontvangstbewijs af te drukken. Het ontvangstbewijs geeft aan dat de kaarthouder
de kaart heeft ontvangen en de kaarthouder kan informatie over de gegevens op de kaart
ontvangen.

Als u deze functie wilt gebruiken, moet u een sjabloon voor de personeelsgroep maken en
opslaan in Access PE Configurator, dialoogvenster: Personnel Groups (Personeelsgroepen).

Acknowledgment

Faoim !Acknowledgement v

Date: 06.08.2008

Acknowledgement of identification badge

Lastname: FPublic S
First name: John B WS“ @ BOSCH

Company:

Public

Firezrams

John B.

Fers ¢ LiXE

Reason of issue:
Please check:

First issue
Replacement f New issue
Badge lost

Badge damaged

Return of badge (%)

Return of damaged badge (%)
Change of name

o Transfer

o Other:

o0cooo0QCo

Code of behavior:

Entering the buisness premises is only permitted while holding a valid badge. The badge must be shown on
demand and may not be passed to other persons. Its loss must be immediately reported to the responsible
issue office.

The badge has to be returned at guitting

Charging of cost in case of loss or damage:

Check, if valick
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Rapporten

U kunt de lijstfuncties in Access PE gebruiken om de database-inhoud op een bepaalde manier
te verzamelen en te structureren in een duidelijk afdrukformaat.

Om de resultaten zo te filteren dat alleen gegevens worden getoond die relevant zijn voor de
betreffende gebruiker kunt u vooraf ingestelde lay-outs gebruiken, die specifieke informatie
geven over een bepaald aspect van toegangscontrole (bijvoorbeeld wie over welke autorisaties
voor bepaalde deuren beschikt).

6.1 Rapporten
Klik op de knop om van de personeelsgegevensweergave om te schakelen naar een
dialoogvenster voor het maken en weergeven van rapporten met betrekking tot
toegangscontrole.
~Reports
|__i Layout IF’ersons j
~Filter
Lastname I First name I
Personnel no. | Card no. I
Card no. from I Card no. to I
Dep./Company I Personnel group I(ngﬁn_er) j
r Filter locations — Filter additional personnel data
Areas | Name .
Field >
— oltside — I(no filter) J
— unknown — Filter I
inside
rFilter authorizations
Authorizations | Name Type salid fram | j
Autharization ()
i . - ;‘
Access point (E) el vl I =
rFilter dewvices
Type | Type MName
Lac
Entrance
Reader
Clear form Search Close
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U beschikt over een aantal rapport-lay-outs en inhoudsfilters:

Lay-out

Beschikbare filters

Beschrijving

Personnel
data
(Personeel
sgegevens)

Last name
(Achternaam)
First name
(Voornaam)
Personnel No.
(Personeelsnr.)
Kaartnr.

Kaartnr. van ... tot
Dept./Company
(Afd./Bedrijf)
Personnel Group
(Personeelsgroep)

Hiermee geeft u
personeelsgegevens weer.
De gegevens kunnen
worden gefilterd met
behulp van een of meer
beschikbare filters. Bij het
gebruik van meerdere filters
zijn deze beperkend
(logische EN).

U kunt bijvoorbeeld alle
personen zoeken waarvan
de naam begint met A en
het kaartnummer zich
tussen 900 en 999 bevindt.
Het sterretje (*) kan als
jokerteken worden
gebruikt om een of meer
tekens, of geen enkel
teken te
vertegenwoordigen.
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Lay-out Beschikbare filters |Beschrijving
Blocked Last name Hiermee geeft u de
Persons (Achternaam) gegevens weer van
(Geblokkee | First name personen met een andere
rde (Voornaam) kaartstatus dan valid
personen) |Personnel no. (geldig) (bijv. explicitly
(Personeelsnr.) blocked (expliciet
Kaartnr. geblokkeerd), 3x wrong PIN
Kaartnr. van ... tot |input (3x onjuiste invoer
Dept./Company PIN-code) of selected for
(Afd./Bedrijf) random screening
Personnel Group | (geselecteerd voor
(Personeelsgroep) | willekeurige controle)) in
het hoofdscherm voor
personeelsgegevens.
De gegevens kunnen
worden gefilterd met
behulp van een of meer
beschikbare filters. Bij het
gebruik van meerdere filters
zijn deze beperkend
(logische EN).
U kunt bijvoorbeeld alle
personen zoeken waarvan
de naam begint met A en
het kaartnummer zich
tussen 900 en 999 bevindt.
Het sterretje (*) kan als
jokerteken worden
gebruikt om een of meer
tekens, of geen enkel
teken te
vertegenwoordigen.
Persons - Last name Hiermee geeft u een
Authorizati | (Achternaam) overzicht van personen en
ons First name de toegewezen autorisaties
(Personen - | (Voornaam) weer. Groepsautorisaties
Autorisatie | Personnel No. zijn gemarkeerd met (G),
s) (Personeelsnr.) individuele autorisaties met
Kaartnr. (E). Ook de geldigheidsduur
Kaartnr. van ... tot |wordt weergegeven.
Dept./Company U kunt desgewenst op een
(Afd./Bedrijf) of meer autorisaties
Personnel Group |filteren. Voor het selecteren
(Personeelsgroep) |van een autorisatie of het
Authorizations opheffen van de selectie
(Autorisaties) ervan volstaat één muisklik.
2018-05 | | APE-Personnel Management Bosch Access Systems GmbH



Access Professional Edition Rapporten | nl 57
Lay-out Beschikbare filters |Beschrijving
Persons - Last name Op basis van de gebieden
Areas (Achternaam) die in het systeem zijn
(Personen - | First name geconfigureerd, wordt
Gebieden) |(Voornaam) zowel de naam van de
Personnel No. personen in de
(Personeelsnr.) geselecteerde ruimte als
Kaartnr. het aantal personen in die
Kaartnr. van ... tot |ruimte weergegeven.
Dept./Company U kunt desgewenst op een
(Afd./Bedrijf) of meer gebieden filteren.
Personnel Group |Voor het selecteren van een
(Personeelsgroep) | gebied of het opheffen van
Locaties de selectie ervan volstaat
één muisklik.
Authorizati | Authorizations Hiermee geeft u een
ons - (Autorisaties) overzicht van autorisaties
Persons en de daaraan toegewezen
(Autorisatie personen weer.
S - Groepsautorisaties zijn
Personen) gemarkeerd met (G),
individuele autorisaties met
(E). Ook de geldigheidsduur
wordt weergegeven.
U kunt desgewenst op een
of meer autorisaties
filteren. Voor het selecteren
van een autorisatie of het
opheffen van de selectie
ervan volstaat één muisklik.
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Lay-out

Beschikbare filters

Beschrijving

Apparaten:

Device type
(Apparaattype)
Device description
(Apparaatomschrij
ving)

Hiermee geeft u een
overzicht van apparaattypen
weer (zoals controllers,
ingangen en lezers).

U kunt desgewenst op een
of meer apparaattypen
filteren. Voor het selecteren
van een apparaattype of het
opheffen van de selectie
ervan volstaat één muisklik.
Apparaten kunnen worden
gefilterd op tekst uit hun
omschrijving. U kunt
bijvoorbeeld alle apparaten
weergeven waarvan de
omschrijving begint met A.
Het sterretje (*) kan in de
apparaatomschrijving als
jokerteken worden gebruikt
om een of meer tekens, of
geen enkel teken te
vertegenwoordigen.
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Lay-out

Beschikbare filters

Beschrijving

Users

s)

(Gebruiker

Last name
(Achternaam)
First name
(Voornaam)
Personnel No.
(Personeelsnr.)
Kaartnr.

Kaartnr. van ... tot
Dept./Company
(Afd./Bedrijf)
Personnel Group
(Personeelsgroep)

Hiermee geeft u een
overzicht weer van
personen die ook
systeemgebruiker zijn,
evenals de
gebruikersrechten die aan
de betreffende personen
zijn toegewezen.

De gegevens kunnen
worden gefilterd met
behulp van een of meer
beschikbare filters. Bij het
gebruik van meerdere filters
zijn deze beperkend
(logische EN).

U kunt bijvoorbeeld alle
personen zoeken waarvan
de naam begint met A en
het kaartnummer zich
tussen 900 en 999 bevindt.
Het sterretje (*) kan als
jokerteken worden
gebruikt om een of meer
tekens, of geen enkel
teken te
vertegenwoordigen.

Persons -
Doors

Deuren)

(Personen -

Last name
(Achternaam)
First name
(Voornaam)
Personnel No.
(Personeelsnr.)
Kaartnr.

Kaartnr. van ... tot
Dept./Company
(Afd./Bedrijf)
Personnel Group
(Personeelsgroep)
Authorizations
(Autorisaties)

Hiermee geeft u een
overzicht van personen en
de toegewezen deuren
weer. Groepsautorisaties
zijn gemarkeerd met (G),
individuele autorisaties met
(E). Ook de geldigheidsduur
wordt weergegeven.
Personen kunnen worden
gefilterd op tekst,
bijvoorbeeld alle personen
waarvan de naam begint
met A.

Het sterretje (*) kan in de
apparaatomschrijving als
jokerteken worden gebruikt
om een of meer tekens, of
geen enkel teken te
vertegenwoordigen.
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6.2

Rapporten: paginaweergave

Het is mogelijk filters in te stellen om de rapportinhoud te beperken tot een subset. Als u geen

filter instelt, worden alle gegevens opgenomen in het rapport. Klik op de knop Search

(Zoeken) om het ophalen van gegevens te starten en ze weer te geven in een
voorbeeldvenster.

md 0

Bericht!
Bij het wijzigen van de filtercriteria wordt het aanbevolen de knop Clear form (Formulier
wissen) te gebruiken om onbedoeld filteren en misleidende rapporten te voorkomen.

Geopende logboekbestanden kunnen worden opgeslagen of worden afgedrukt. Via het menu-

onderdeel File > Print (Bestand > Afdrukken of de knop

[l ]

M Access Control System - Bosch Access Professional Edition

o4 N 48 [ ooz

Access Control System - Bosch Access Professional Edition

EventLog report

Date Lacipc ReaderiLogin

Losation fprogram  Lastname,fetnams  Camdne.  Company

Message

26.05.2009 14:10:31 LAC-1 Pracessord

Board 0

enlin (ready)

25052009 14:19:31 LAC-1

Progrm dou nlc

26.05.2009 14:10:32 LAC-1

Main entranee - north

Doorin narmalt

26061009 14:19.32 LAC-1

Main entranee - seuth

Doarin narmalt

26.05.2009 14:10:32 LAC-1

Entrance-3

Daorin narmal

26061009 14:19.32 LAC-1

-4

25.06.2009 14:18.82 LAC-1

26061009 14:19.32 LAC-1

25.06.2009 14:18.82 LAC-1

26.06.2009 14:19.32 LAC-1

25.06.2009 141940 LAC-1

26.06.2009 14:10:41 LAC-1

25.05.2009 1435118

LACSP

26.06 2009 143821

Lacse

25.05.2009 143523

LACSP

wordt een voorbeeld geopend.
EEX

md 0

Bericht!
Alle geopende logboekbestanden worden afgedrukt.

Sluit alle bestanden die niet hoeven te worden afgedrukt,

belangrijke berichten.

of beperk de selectie voor de

De rapportpaginaweergave biedt een aantal functies voor het wijzigen en bedienen van de

weergave:
Knop Betekenis |Beschrijving
® Exporteren | De lijst kan voor verdere

bestandsindelingen zijn
beschikbaar:

Format (PDF)
Door komma's gescheiden
waarden (CSV)

verwerking worden geéxporteerd
naar een bestand. De volgende

Acrobat Portable Document
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Knop Betekenis |Beschrijving

5 Afdrukken |Hiermee drukt u het rapport af via
een afdrukvenster waarin u een
standaardprinter kunt instellen.

PRV Pagina Met de pijlknoppen gaat u naar de
selecteren |eerste, vorige, volgende of laatste
pagina van het rapport. Dit
besturingselement geeft ook het
huidige paginanummer en het
totale aantal pagina's in het
rapport weer.

I Aantal Vraagt om de huidige pagina en
pagina’s het totale aantal pagina's.
| In-/ U kunt desgewenst een andere

uitzoomen |schaal dan de standaardschaal
van de weergave (100%)
selecteren.

Lijsten exporteren
Druk op de knop @ om een dialoogvenster te openen waarin de exportcriteria kunnen worden
ingevoerd.

o )

Expaortieren

Formatieren:

=l

Ziel: abbrechen

|Ig Sdobe Acrobat (P

kg

|I§ Datentragerdatei j

Beschreibung

Adobe Acrobat ist ein seitenbasiertes Format, mit dem Dokumente Fir -
den Druck oder die Weitergabe erzeugt werden. Im Acrobat-Format 1l
werden sowohl Formatierung als auch Lavout in Ubereinstimmung it =—
der Darstellung des Berichts auf der Registerkarte "vorschau® -

Het selectielijstveld Format (Formaat) biedt de uitgangsformaten .pdf (voor het doorsturen en
archiveren van specifieke zoekresultaten) en .csv (voor verdere gegevensverwerking).
Wanneer gegevens naar een csv-bestand worden geéxporteerd, kunnen deze in zekere mate
verder worden verwerkt.
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o )

Dptiohen fur den Export getrennter Werke @

Zeichenoptionen

oK
Trennzeichen: i

abbrechen
Trennzeichen: | [ Tabstopp

Modus: |Stan|:|arl:|m-:u:|l.ls j

Bericht- und Seitenbereiche:
(+ Exportieren [ Bericht-/Seitenbereiche isolieren
" Micht exportieren

Gruppenbereiche;
¢ Exportierern | Gruppenbereiche isolieren

(" Nicht exportieren

Naast de begrenzings- en exportmodus kunt u ook rapport- en paginasecties (kolomkoppen
en paginadetails) en groepsecties (geselecteerde gegevens) van export uitsluiten of isoleren.
U kunt een van de volgende opties gebruiken als Destination (Bestemming).

—  Application (Toepassing) — opent het bestand met de juiste toepassing. Deze toepassing
moet ook op de computer worden geinstalleerd. Pdf-bestanden worden geopend met
Adobe Acrobat Reader en csv-bestanden worden geopend met MS Excel.

— Disk file (Schijfbestand) (standaard) — opent een Explorer-dialoogvenster waarin u de
gewenste map kunt selecteren. Er wordt een naam voorgesteld waarmee het bestand kan
worden opgeslagen.

—  Exchange folder (Exchange-map) — het bestand kan direct naar een MS Outlook-
ontvanger worden verzonden.

—  Lotus Domino Mail — het bestand kan direct naar een Lotus Mail-ontvanger worden
verzonden.
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7 Lokale opnamen

Momentopnamen en video's opnemen

De videosequenties die worden weergegeven via de dialoogvensters van het
toegangscontrolesysteem, worden genomen van de video-opnameapparaten waarop de
geconfigureerde bewakingscamera's zijn aangesloten. Afhankelijk van de opslagcapaciteit van
het apparaat worden de oudste opnamen overschreven door de nieuwste opnamen
(ringvormige buffer).

Om bepaalde gedeeltes te bewaren kunt u lokale kopieén van losse beelden of video's
kopiéren. Als u het standaard installatiepad gebruikt, worden beelden en video's bewaard
onder C:\BOSCH\Access Professional Edition\PE\Data\Video.

o | .
Druk op de knop om een momentopname in jpg-formaat op te slaan als
<apparaatnaam>_jjjjMMdduummsstttt.jpg
[j= jaar, M= maand, d= dag, u= uur, m= minuten, s= seconden, t= duizendsten van seconden].

Druk op de knop @ om te beginnen met het opslaan van de sequentie die momenteel
wordt uitgevoerd; druk nogmaals op de knop om de sequentie te beéindigen. Deze lokale
kopie van de video-opname heeft dezelfde naamgeving als de beelden en wordt opgeslagen

in .vxx- of .mpeg-formaat. Om het .vxx-formaat als video te bekijken kunt u geen standaard
marktproduct gebruiken. Om deze lokale kopieén te kunnen bekijken moet u de meegeleverde
Bosch Video Player gebruiken.

Druk op de knop ﬁ om een momentopname van de huidige weergave van een Point of
Interest (POI, interessepunt) op te slaan. _POI wordt toegevoegd aan het begin van de
bestandsnaam: _POI <apparaatnaam>_jjjjMMdduummsstttt.jpg.

[j= jaar, M= maand, d= dag, u= uur, m= minuten, s= seconden, t= duizendsten van seconden].
Er wordt ook een logboekbericht gemaakt als markering.

Bosch Video Player

De momentopnamen kunnen worden geopend met nagenoeg elk viewerprogramma of elke
internetbrowser. De video-opnamen hebben echter een speciaal formaat en moeten worden
geopend met de Bosch Video Player.

Bericht!
U kunt de videosequenties die zijn opgeslagen in .mpeg-formaat met elke willekeurige speler
weergeven.

mud 0

Het dialoogvenster is bewust eenvoudig gehouden en heeft slechts twee knoppen naast het
videoweergaveveld, namelijk open file (bestand openen) en start/stop.

Druk op open file om in de standaard opslaglocatie van de video-opname te bladeren (C:\)
naar de gewenste bestanden.

Nadat u het videobestand hebt geselecteerd, wordt het pad weergegeven in de Video Player. U
het geselecteerde bestand op elk moment weergeven door op start te drukken. Terwijl de
video wordt afgespeeld verandert de startknop in stop, zodat u het afspelen kunt
onderbreken.
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8

8.1

Gebruikersrechten

De gebruikersrechten voor Access PE-toepassingen (en voor Configurator en LogViewer)
worden in Personnel Management toegewezen op een speciaal tabblad voor
personeelsgegevens (= gebruikersrechten).

Gebruikersrechten

Dit tabblad verschijnt alleen als de gebruiker zich heeft aangemeld met beheerdersrechten.
Alleen beheerders kunnen hun eigen rechten en die van andere gebruikers instellen en
wijzigen.

Personnel data and authorizations @
1 FPersonnel Data | r' Access Authonzations IEI User Rights |% Additional Data |
Type of user
" Ma rights
Usemame |Bosch
User-administrator £ User
Pazsword |
SV e % Uzer-administrator
Canfirmnation
| zer rights for persons Jzer rights for configuratar

= 5 L
I v iew personnel data I [¥ Change authonizations I W Configuration of system

User rights for door management

I [v Open / lock door [lang-term)

Uszer rights for video devices Uger rights for video functions Uzer rights for logwiewer

Iv Cateqory 1 [ Live viden I [v ‘iew own meszages

¥ Category 2 W Archive I [¥ ‘iew all meszages without personal data
¥ Category 3 v Export ¢ record I [v iew all meszages

Ok | Abbrechen Hilfe

Als een persoon gebruikersrechten voor Access PE-toepassingen moet ontvangen, moeten
deze expliciet worden toegewezen. Alle personen worden standaard zonder gebruikersrechten
geconfigureerd.

Als u gebruikersrechten wilt toewijzen, voert u een gebruikersnaam en een wachtwoord in.
Standaard wordt de achternaam van de persoon voorgesteld als gebruikersnaam, maar u kunt

desgewenst een andere gebruikersnaam opgeven. Het wachtwoord heeft een maximumlengte
van 16 tekens, is hoofdlettergevoelig, en mag speciale tekens bevatten.

md 0

Bericht!

Het wordt ten zeerste aanbevolen een aparte gebruikersaccount te maken voor elke persoon
die het systeem gaat gebruiken. Maak geen algemene gebruikersaccount die door
verschillende personen wordt gebruikt. Alle gegevensinvoer, -wijzigingen, enz. worden
geregistreerd onder de naam van de gebruiker die ze uitvoert, maar dit is alleen zinvol als elke
gebruiker zijn/haar eigen wachtwoord heeft en de gebruikersinstellingen worden gewijzigd
(Gebruikersoverdracht en werkstationbeveiliging, pagina 67) elke keer dat het werkstation

door een andere persoon wordt gebruikt.
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De standaardinstallatie bevat één vooraf gedefinieerde beheerder. Wanneer deze vooraf
gedefinieerde gebruiker is aangemeld, kan een willekeurig ander type gebruiker of een
beheerder worden toegevoegd en gewijzigd.
Het enige verschil tussen beheerders en normale gebruikers is dat beheerders
gebruikersrechten kunnen toewijzen en wijzigen. Alle gebruikerstypen zijn identiek op het
gebied van de beschikbaarheid van toepassingen of de toegang tot gegevens en
logboekbestanden. Elke gebruiker kan met beperkte of onbeperkte gegevenstoegang worden
geconfigureerd.

Als een van de beheerdersopties wordt gekozen, worden de verschillende groepen

gebruikersrechten voor Access PE-toepassingen geactiveerd en kunnen deze individueel
worden toegewezen.

De volgende gebruikersrechten kunnen worden toegewezen:

Toe- Gebruikersr|Beschrijving
passing echt
Personnel |View Alleen het dialoogvenster met
data personnel |personeelsgegevens kan worden
(Personeel |data opgeroepen. De locatie van
sgegevens) | (Personeel |personen wordt niet weergegeven.
sgegevens | Wijzigingen zijn niet toegestaan.
weergeven)
Edit De personeelsgegevens kunnen
personnel |worden weergegeven en gewijzigd.
data De locatie van personen wordt niet
(Personeel |weergegeven.
sgegevens
bewerken)
Change Deze optie kan alleen in
location combinatie met een van de
(Locatie bovenstaande opties worden
wijzigen) gebruikt.
Als View personnel data
(Personeelsgegevens weergeven)
is geactiveerd, kunnen locaties
alleen worden weergegeven.
Als Edit personnel data
(Personeelsgegevens bewerken) is
geactiveerd, kunnen locaties ook
worden gewijzigd.
Toegangsa |Het tabblad Access authorizations
utorisaties |(Toegangsautorisaties) is alleen
wijzigen beschikbaar als dit selectievakje is
ingeschakeld.
Configurat |Configurati | Met deze optie activeert u de
or on of volledige gebruikersrechten voor
system Configurator.
(Systeemc

onfiguratie)
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Toe- Gebruikersr|Beschrijving
passing echt
Door Open /lock |Deurbeheer wordt geactiveerd voor
manageme |door (long- | het menu met dezelfde naam, en
nt term) via het snelmenu in de lijst van
(Deurbehe | (Deur apparaatstatussen (in Personnel
er) openen/ management en Log viewer).
vergrendel
en
(langdurig)
)
Log viewer |View own |Hiermee worden alle
message logboekmeldingen gefilterd,
(Eigen behalve de meldingen die
melding betrekking hebben op de gebruiker
weergeven) | zelf.
View all Hiermee worden alle
messages |logboekmeldingen weergegeven
without maar zijn de personeelsgegevens
personal niet zichtbaar.
data (Alle
meldingen
zonder
personeels
gegevens
weergeven)
View all Hiermee worden alle meldingen
messages |ongecensureerd weergegeven.
(Alle
meldingen
weergeven)

Toegewezen gebruikersrechten zijn gemarkeerd met een vinkje in het selectievakje en het

symbool ﬁ naast het gebruikersrecht. De volgende figuur illustreert de activering van alle
gebruikersrechten. Alle selectievakjes kunnen zonder risico van conflicten worden
ingeschakeld omdat automatisch de meest uitgebreide set van rechten wordt toegepast.
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8.2 Toegangsrechten van gebruikers instellen

Het systeem wordt geleverd met voorgeconfigureerde gebruikers-beheerder-rechten.

Een gebruiker met als naam en wachtwoord bosch is standaard aanwezig.

Alleen beheerders kunnen andere gebruikers instellen.

Waarschuwing!

Deze gebruiker en wachtwoord zijn standaard onderdeel van het pakket en worden niet

aangepast voor iedere koper van de software. Het wordt daarom ten zeerste aanbevolen ze

eerst te gebruiken om uw eigen accounts met beheerdersrechten in te stellen en daarna de
originele account aan te passen of te verwijderen alvorens u het programma in gebruik neemt.

U kunt verdere gebruikers als volgt instellen:

4 BOSCH

1. Start Access PE Personnel Management met het bureaubladpictogram & en meld
u aan met de voorgeconfigureerde Gebruiker-beheerder-account.

2. Open het dialoogvenster om personeelsgegevens toe te voegen met de knop g of via
het menu Persons > New Person (Personen > Nieuwe persoon)

3. Voeg een nieuwe gebruiker toe door ten minste een naam en een personeelsgroep in te
voeren

4. Klik op het tabblad User Rights (Gebruikersrechten) en
- wijzig, indien nodig, de gebruikersnaam
- wijs een wachtwoord toe
—  specificeer het type gebruiker (User (Gebruiker) of User-Administrator (Gebruiker-

beheerder)).
—  wijs rechten om gegevens te wijzigen toe aan deze gebruiker.
—  Bevestig uw invoer en sluit het dialoogvenster door op OK te klikken.

5. Meld u af bij Personnel Management (Personeelsmanagement) door te klikken op .
of via het menu Extras > Logon (Extra > Aanmelden) en bevestig de veiligheidscontrole
door met Yes (Ja) te antwoorden.

6. Gebruik de knop . of het menu nogmaals om u aan te melden met de gegevens van
de gebruiker die u net hebt toegevoegd.

8.3 Gebruikersoverdracht en werkstationbeveiliging

Gebruikersoverdracht

Als een gebruiker de controle overdraagt op een andere gebruiker op hetzelfde werkstation,
moet de overdracht expliciet binnen het systeem plaatsvinden. Deze overdracht kan worden
uitgevoerd terwijl het systeem actief is. Access PE hoeft niet opnieuw te worden gestart.
Eerst moet de huidige gebruiker zich afmelden. Hiertoe klikt deze gebruiker op de

werkbalkknop . Er wordt een veiligheidscontrole uitgevoerd: Do you want to end your
work with user rights? (Wilt u uw werkzaamheden met gebruikersrechten beéindigen?)
Na de bevestiging schakelt het systeem naar de standaardweergave terug.
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Doves ste | e | Vo i |

Vervolgens moet de nieuwe gebruiker zich aanmelden door op de knop . te klikken.

Werkstationbeveiliging

Als een werkstation tijdelijk onbeheerd is op een toegankelijke plaats, is het van groot belang

te zorgen dat er geen ongeoorloofde toegang mogelijk is tot de personeelsgegevens. Hiervoor

zijn verschillende oplossingen beschikbaar:

- U wordt aangeraden Configurator en Log Viewer niet op dergelijke werkstations te
installeren.

—  Meld u af bij Personnel Management wanneer het programma niet in gebruik is. Klik

hiervoor op de knop . zodat de veiligheidscontrole wordt uitgevoerd, zoals
hierboven is beschreven. De personeelslijst blijft zichtbaar maar er is geen toegang meer
mogelijk tot de personeelsgegevens.

—  Sluit de toepassing met File > Exit (Bestand > Afsluiten) of klik op de x-titelbalkknop van
het venster. Als u de personeelslijst wilt raadplegen, moet u de toepassing opnieuw
starten.

—  Vergrendel de computer met behulp van de standaard Windows-functie: Druk op Ctrl +
Alt + Del en selecteer Lock Computer (Computer vergrendelen) in de weergegeven
systeemfuncties. Aangezien dit de standaardfunctie is, kunt u Lock Computer (Computer
vergrendelen) doorgaans sneller uitvoeren door gewoon op Enter te drukken. Alleen de
huidige gebruiker of een gebruiker met Windows-beheerdersrechten kan het systeem nu
ontgrendelen.
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9 UL 294-vereisten

Functies die niet zijn geévalueerd door UL:
—  Het systeem van videoverificatie
—  Plattegrondweergave en alarmbeheer met plattegrond- en videoverificatie
- Video Player
- Badge Designer
—  De Delta 1200 Series
—  Rosslare ARD-1200EM Series
—  LAC-controllers
-  LACi-controllers
- APC-AMC2-4R4CF-controllers
- BG 900-lezer met interfaceprotocol
—  L-BUS-lezer met interfaceprotocol
— IDS van beveiligingssysteem - In-/uitschakelen van alarm
- Liftgebruik
- Teksten
-  Logboek
—  Personnel Management (Personeelsbeheer)
—  Kaarten maken
- Rapporten
—  Gebruikersrechten
—  Gebruik van inbraakalarm

Functies die zijn geévalueerd door UL:

—  26-bits Wiegand-formaatlezers

- AMC2-controllers:

APC-AMC2-4WCF

API-AMC2-4WE

API-AMC2-8I0E

API-AMC2-1610E

- APE-SW als aanvullende bewakingsapparatuur
De volgende Bosch-kaartlezers zijn door UL geévalueerd voor compatibiliteit met het APE-SW-
softwaresysteem van Bosch:

—  LECTUS secure 1000 WI

- LECTUS secure 4000 WI

—  LECTUS secure 5000 WI
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